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1 Introduction 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

Welcome to Kramer Electronics! Since 1981, Kramer Electronics has been providing a world of unique, creative, and 
affordable solutions to the vast range of problems that confront video, audio, presentation, and broadcasting 
professionals on a daily basis. In recent years, we have redesigned and upgraded most of our line, making the best 
even better!  

Our 1,000-plus different models now appear in 14 groups that are clearly defined by function: GROUP 1: Distribution 
Amplifiers; GROUP 2: Switchers and Routers; GROUP 3: Control Systems; GROUP 4: Format/Standards Converters; 
GROUP 5: Range Extenders and Repeaters; GROUP 6: Specialty AV Products; GROUP 7: Scan Converters and 
Scalers; GROUP 8: Cables and Connectors; GROUP 9: Room Connectivity; GROUP 10: Accessories and Rack 
Adapters; GROUP 11: Sierra Video Products; GROUP 12: Digital Signage; GROUP 13: Audio; and GROUP 14: 
Collaboration. 

Congratulations on purchasing your Kramer Room Controller device, which is ideal for controlling A/V equipment and 
media room items. The configuration software is part of the package and includes the Kramer K-CONFIG Guide.  
The Kramer K-CONFIG software lets you set a sequence of actions in a trigger (a macro) and assign them to any of 
the configurable buttons on any of the relevant RC devices, a schedule or an event. 

 
Note that the RC buttons can be configured prior to installation. 

This online guide accompanies the K-CONFIG application software for Kramer room controllers and is compatible with 
previous versions. Download up-to-date Kramer user manuals and guides from the Internet at this URL: 
http://www.kramerav.com/manual/K-Config 3. 

1.1 Overview  

K-CONFIG is an intuitive configuration application that easily maintains control driver libraries, creates room control 
macros and protocols, and automatically generates HTML files where applicable. K-CONFIG supports a revised GUI, 
adds a host of advanced and easy to use features and uses a revamped driver database. The easy workflow shared 
between all Kramer control products enables a “Learn once – use forever” approach. 

The K-CONFIG: 

• Is a simple to use Graphical User Interface design, and no programming knowledge is required. 

• Is powerful and updateable by the user driver database.  

• Features a flexible querying system for projectors lamp hours, fans status and similar information. 

• Includes an easy-to-use messaging system all the way to the Site-CTRL AV site monitoring application. 

• Is compatible with current Windows versions: Windows 7 and Windows 8. 

http://www.kramerav.com/manual/K-Config%203
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1.2 System requirements: 

This section defines the minimum requirements for the Kramer K-CONFIG and describes how to install your system. 

1.2.1 System Requirements for the Kramer K-CONFIG 

The system minimum requirements include: 

• 1GHz or faster processor 

• 1GB or more RAM 

• At least 1GB free hard disk space 

• Network connection for configuring devices or USB. 

• Microsoft.NET® Framework 3.5, automatically installed (see Section  2.1). 

1.2.2 Operating Systems 

Microsoft Windows 7 (32 or 64 bit) or Microsoft Windows 8 (32 or 64 bit) are the recommended operating systems 
(Windows NT does not support .NET 2.0 and cannot be used). Other Windows versions are not supported. 
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2 Planning the Controlled Room 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

Carefully plan your room controller system layout to ensure smooth configuration and installation of the system. The 
following table summarizes the basic configuration and installation steps: 

Stage K-Config Tool Description 
Plan  List room devices, location, connectivity and main commands 
Install HW system  Connect room AV, Lighting, Automation and Control system  
Set SW drivers Driver Manager Get device drivers and set proper device commands and responses 
Set control SW system Project Navigator and 

Port Manager 
Set controllers, keypads and gateways 
Assign control ports connectivity to controlled devices 

Configure control SW 
program 

Triggers and Action 
Editor 

Assign commands & actions to UI and triggering events 

Activate control system Connect Sync control SW program to HW system 
Validate proper control system operation 

The following are the steps that will get you going: 

A: Define the room requirements; list the items required, plan the location and function of the devices; prepare a 
detailed list of the functions and commands required of the system devices: 

Device Function Connected to Sample Commands  

Projector Main room display RS-232 On/off, input selecting, blank, freeze, menu, and so 
on 

LCD Display Local Monitor RS-232 On/off, input selecting, volume, aspect ratio, Freeze, 
Menu, and so on 

Laptop Input the lecturer’s laptop Ethernet Use the RC’s Web page, perform “Test command” 
when installing the RCs in the room. 

VP-81SIDN Inputs of different user  RS-485 Select input, mute, volume, and so on 

VP-771 Select a source Ethernet Input selecting, PIP, Blank, mute and so on 

DVD Player Input the DVD Player IR On/off, play/stop and so on 

Power Amplifier Amplify the volume IR On/Off, volume, select input, mute on/off, and so on 

Projector Screen Roll down and roll up Relay Up, down 

Lighting System Set the lights Relay On, off, dim 

Motion detector Burglar detection GPI/O  

Other functions you would like to have in the room include general command sequences such as weekend shutdown, 
room startup and so on. 



 

4 K-CONFIG - Planning the Controlled Room 

 

B: Set up the system in the room.  

 

 
Note that you can also connect the system at a later stage, when testing the commands.  

 

C: Check, according to the list, that all the device drivers appear in the K-CONFIG Driver Tree (see Section 5). For 
example, if you are using a Hitachi Projector, check that its driver is part of the drivers list. If it is not, and you do not 
have the driver to a device (for example, a projector), you can either request it from Kramer’s tech support or 
download the manufacturer’s protocol from the Web, and create it yourself via K-CONFIG. 
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D: Set the serial replies, the queries and the tables via the Driver Manager: 

 

E:  Add the Master and auxiliary devices to the Project Navigator:  
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F: Set the ports via the port manager (assign the controlled items and devices to the Master and auxiliary devices): 

 
The port description now appears in the control room: 
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G: Configure the commands:  

  

H: Connect, write the configuration to the device (“Sync to device”) and test the system. 

Note that at any time you can add commands or devices in the same way. 

2.1 Glossary 
The glossary in the table below defines common terms used throughout this manual:  

Glossary 
Action A command that performs an action (for example, Mute the sound on the power amplifier). Actions are 

grouped into Action Types based on their function (for example, Button Light) 
Action List A list of actions which are performed one after another in the order they were added to the action list. An 

action list is performed as a result of a Trigger. 
Auxiliary Device A secondary room control device (K-NET ID number=2 and on) such as a room controller, control keypad, 

keypad or virtual keypad device. 
Control Gateway 
(aka I/O proxy device 

Control gateway devices (such as the Kramer FC-28 gateway) which are connected to a master room 
controller via an Ethernet port. Used to expand the number of I/O ports available for connecting controlled 
devices. 

Control Keypad 
Device 

Integrated room controller and keypad device (such as the Kramer RC-74DL), typically having direct I/O 
ports, serving as either master or auxiliary room controller. 

Controlled Device 
(aka Peripheral 
device) 

Peripheral devices (such as TV displays, projectors, DVD players, switchers, scalers, sensors, door locks, 
light switches and dimmers, shades, blinds, drapes and so on) that are controlled by a room controller device 
via I/O interface connections. 

Driver A communication protocol used for controlling a controlled device by a Kramer controller, as specified by the 
controlled device vendor. 

GPI/O General Purpose Input / Output port, with multiple operation modes as configured by K-CONFIG. It is 
typically used to interact with common room sensors (such as an occupancy sensor, temperature sensor and 
so on). 

I/O interface (aka I/O 
port) 

Any Ethernet, Serial, IR, GPI/O, or Relay control interface, connecting between the room controller and the 
controlled devices, either directly or via a control gateway. 

Keypad Device Keypad-only UI device (such as the Kramer RC-54DL keypad) without an integrated room controller, with 
hard buttons, knobs, LCD displays and similar UI control keys. 

Master Room 
Controller 

The main controller device (by default, K-NET ID number=1) in a room control system to which auxiliary 
controller devices, controlled devices, UI devices and control gateways are connected. 

Room Controller 
Device 

A room controller device running a control program, as configured via K-CONFIG, that controls room 
controlled devices (connected via I/O interfaces) according to UI-generated user commands. It serves as 
either master or auxiliary room controller. 
A room controller can be a HW-based controller unit (such as the Kramer SL-1N controller or the RC-74DL 
control keypad) or a Server SW-based virtual controller device (such as the KRAMER NETWORK controller). 
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Glossary 
Touch Panel Device Touch UI panel (such as the Kramer KT-10 touch panel) with SW-based buttons, knobs, LCD displays and 

similar UI control keys. 
Trigger An event that starts the execution of an Action List, such as a button press, knob rotation, scheduled event, 

monitored event and so on 
UI Device User-interface device, with physical (such as a keypad) or SW-based (such as touch panel) buttons and 

knobs, configured for user room control operation. 
Virtual Keypad 
Device (aka Virtual 
Device)  

A SW-based keypad UI virtual device accessed via Web-browser for user room control operation through its 
multiple GUI panels, as configured in K-CONFIG. When connected to a Master room controller via Ethernet 
port, it can serve as an auxiliary UI device. 

Virtual Panel A GUI panel with multiple SW-based GUI elements, configured in a virtual keypad device for user room 
control operation. 

Virtual Room 
Controller Device 
(aka Virtual Master) 

A SW-based master room controller in KRAMER NETWORK control systems, as created in K-CONFIG and 
managed in KRAMER NETWORK server. 



 

K-CONFIG – Kramer K-CONFIG Software Installation 9 

 

3 Kramer K-CONFIG Software Installation 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

To install the K-CONFIG software: 

• Check that “.NET Framework” Revision 4.0 software is installed or install it if it is missing (see Section  3.1). 

• Install the USB driver (see Section  3.2). 

• Install the Kramer K-CONFIG software (see Section  3.3). 

3.1 Installing the “.NET Framework” Revision 4.0 (or higher) Software 

Prior to using the Kramer K-CONFIG software, make sure that the “.NET Framework” Revision 4.0 (or higher) software 
is installed on your PC. If it is not, you need to install it: 

• If you have a fast Internet connection, this software is automatically installed during the installation of the Kramer 
K-CONFIG software.  

3.2 Installing the USB Driver 

If you wish to configure the RC device by connecting it via a USB cable, you need to download and install the USB 
driver. Download the Kramer USB driver from the installation disc or from our Web site at 
http://www.kramerav.com/manual/K-Config 3, save it on your PC and extract the zip file to a directory where you can 
find it later. 

Connect the mini USB cable from your PC to the device and wait until Windows 7 completes the connection and will 
report in a bubble that "Device driver software was not successfully installed" (If the device driver is installed 
successfully, skip the rest of section). 

 
 

 
Figure 1: USB Driver Installation –USB Installation Attempt 

 

http://www.kramerav.com/manual/K-Config%203
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To install the USB driver: 

1. Open Control Panel -> Device Manager … 

2. Right click the Kramer USB –COM DEVICE driver: 

 
Figure 2: USB Driver Installation – Select USB Driver Properties 

3. Select Properties. 
The Properties window appears: 

  
Figure 3: USB Driver Installation –USB Driver Properties Window 
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4. Click the Update Driver… window. 
The following window appears: 

 
Figure 4: USB Driver Installation – USB Driver Update 

5. Select Browse my computer for driver software and then set the location of the driver on your PC: 

 

Figure 5: USB Driver Installation – USB Driver Location 
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6. Click the Next button. The Windows Security window appears: 

  

Figure 6: USB Driver Installation – Windows Security 

7. Select Install this driver software anyway. 

8. When the installation is completed, the following window appears: 

 

Figure 7: USB Driver Installation – USB Driver Updated 

The PC recognizes the USB port to which the device is connected. 
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Figure 8: USB Driver Installation – USB Recognized on PC  

3.3 Installing Kramer K-CONFIG Software 

To download Kramer K-CONFIG from the Internet (note that file names are liable to change from time to time): 

1. Go to the Kramer K-CONFIG Web page and download the file: “Kramer K-Config.zip” from the DOWNLOADS 
section. 

2. Extract the file “Kramer K-Config.zip” package, which includes the Kramer K-CONFIG application setup and 
the Kramer device drivers, to a folder (for example, C:\Program Files\Kramer K-Config). 

3. Install the Kramer K-CONFIG application (follow the instructions on screen). 

 
Figure 9: Application Installation 
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4. Click Install. 
The following window appears. 

 
Figure 10: Installing Kramer K-CONFIG 

5. Wait for completion of the installation 

6. The following window appears (see Figure 11): 

 
Figure 11: End User License Agreement 

7. Check I Agree and click the Next button. 
The Registration window appears: 
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Figure 12: Registration Window 

8. Fill in the details (note that this information is for internal use only) and click OK. 

9. Upon completion, the K-CONFIG opens and then the K-CONFIG message appears: 

. 

Figure 13: KRAMER K-CONFIG Software  

10. When installing for the first time, the following message appears: 

. 

Figure 9: Default Driver Message 
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11. If you want to set the default click Yes (and continue to step 4) and if not, click No. 
The following window appears: 

 
Figure 14: Setting a Working Directory 

12. Select or create a new working directory (see Figure 15). 
The working directory will keep the information that is essential for operating the software. This information will 
remain unchanged while upgrading the software 

13. If you need to change the working directory, click the Browse for folder button, select the working directory 
and click OK.  
If you do not need to change the working directory, go to the next step. 

 
Figure 15: Change the Working Directory Window 

14. Once the working directory is selected, click the Set to Default Location button. 

 
Figure 16: Drive Database Loaded 

15. Click OK. 
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Figure 17: Installation Complete. The main window opens 
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4 Getting to Know K-CONFIG 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

Following the installation, you can click the K-CONFIG icon to open the software: 

 
Figure 18: Opening K-CONFIG 

If the selected folder does not contain any drivers, the following message appears. 

 
Figure 19: Opening K-CONFIG 

The Kramer list of Master/auxiliary devices is automatically installed. 
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If you need to install drivers to an existing data base: 

1. Click the Import Drivers button to import drivers.  
The following window appears: 

 

Figure 20: Import Drivers Window 

2. Select the files to import and click OK. 
The imported drivers are arranged in the expanded Drivers Tree as follows (note that you can sort the drivers 
according to the vendor, the device type or by typing a keyword): 
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Figure 21: Drivers Tree – with Imported Drivers, Sorted by Vendor, Device Type or by keyword 

4.1 The Main Window 

The K-CONFIG main window is modular and can be altered according to your needs. You can change the size and 
location of each window in the layout separately, replace it, delete it or add other windows. The K-CONFIG main 
window default layout includes the five most frequently used windows: 

• Project Navigator – shows the room controllers and the controlled devices. 

• Triggers – shows the list of available triggers, arranged in Event categories. 

• Action list – shows the list of actions in a selected trigger. 

• Device View – the front panel view of the selected device. 

• Action Editor – lets you create an action to add to the action list. 

The remaining optional windows which are not accessed as often appear in the Windows menu and include the: 

• Port Manager – lets you assign drivers and other characteristics to the ports. 

• Device Settings – general, security, Ethernet and date and time settings. 

• Web Settings – logo and Web page settings. 
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Figure 22 shows the main screen default layout appears: 

 

Figure 22: Opening K-CONFIG Default Layout for the First Time 

Each user can tailor the main screen appearance according to his/her work flow and needs. To facilitate this, the 
windows in the main screen can be dragged and positioned to a different location via the drag and drop tool (illustrated 
Figure 23). For example, to move the Triggers window in the main screen, drag the Triggers window away from its 
current location (see Figure 24). 

 
Figure 23: Dragging the Triggers Window 
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Select the new location by moving the Triggers window towards one of the drag and drop tools circled in Figure 24: 

 
Figure 24: Drag and Drop Tool 

For example, to place the Triggers window at the left, drag the Triggers window to the left drag and drop tool. The 
Triggers window appears at the left: 

 
Figure 25: Triggers Window Repositioned 
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In the same way you can move the selected window to be in a separate first/last row, between other windows in the 
row or the first/last column. The main screen can have an appearance that is different than the default layout and is 
suited for your use, as shown in the example in Figure 26: 

 
Figure 26: Customized window setup 

In the same way you can also add additional windows, for example, the Port Manager window, as illustrated in the 
example in Figure 27. Select Port Manager from the Windows menu and click the drag and drop tool: 

 
Figure 27: Adding the Port Manager Window to the K-CONFIG Layout 
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The Port Manager window is added to the main window: 

 
Figure 28: The Port Manager Window Added to the K-CONFIG Layout 

The same setup will reappear the next time you launch K-CONFIG. At any time you can reset to the factory default 
view by clicking Default Layout in the Windows menu. 
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4.2 The K-CONFIG Menus 

This section describes the K-CONFIG menus. 

4.2.1 The File Menu 

This section defines the File Menu for creating and updating project files which are downloaded to the room controllers 
for controlling the room controlled devices. Note that the same project file can be reused in multiple controllers for 
controlling multiple rooms. 

 

 
Figure 29: The File Menu 

 
Menu Command Function 

New Project Select to create a new project, see Section  4.2.1.1 
A project includes the control program configuration as well as the 
drivers for the controlled devices. 

New K-Network 
Project 

Select to create a new Kramer Network Project  

Open Project Open an existing project, see Section  4.2.1.1  
Save Project Select to save the current project, see Section  4.2.1.2 
Save Project As Save the project under a different name, see Section  4.2.1.2 
Auto Save Project You can choose to save the project automatically (yes) or not (no). 

When selecting yes, the configuration is saved periodically, every 30 
seconds, if the project was changed/edited 

Upload Project You can choose to upload the project file (kpr) to the device or not, 
see Section  10.7.1 

Export Configuration For using the batch configuration upload feature with Site-CTRL 
When exporting a configuration, the file name automatically includes 
the master room controller name and the date it was saved. For 
example,  
SL-10-Configuration-Sep10.kpt 

Set Working Directory Click to set the working directory. You can change the working 
directory any time 

 
Driver Manager  Click to open the Driver Manager window  
Import Device Click to import a new or existing Kramer controller devices` XML, see 

Section  4.2.1.3 
You can import one or several new and/or revised device layouts to 
K-CONFIG and virtual device layouts created in other K-CONFIG 
installations 

Export Device Click to export a device, Section  4.2.1.3  
You can export virtual device layouts to other K-CONFIG installations 

Recent Projects Lists the recent projects worked on 
Exit Click to exit the program 
  

4.2.1.1 Starting a New Project 

To start a new project, select New Project in the file menu (or click the New Project icon ( )). To start a new project 
for Kramer Network, select New K-Network Project (see Section  12 12.1)  
If you have an open project in K-CONFIG and had made changes to it (this is indicated by the Asterisk next to the 
project name ), the following window appears: 

 

Figure 30: New Project Warning 
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If you want to save the changes click No and save the project before opening a new one. If you do not need to save 
the changes, click Yes and a new project will open. 

To open an existing project, select the project via “Open Project” ( ) or “Recent Project” and select the project. 

4.2.1.2 Saving a Project 

To save the project, click Save or Save Project As in the File menu. The following window appears: 

 
Figure 31: Saving a Project 

When saving, writing or opening a new project, follow these important rules: 

• In the File menu, you can set Auto Save Project to yes so that the project is automatically saved. If it is not 
automatically saved you will see an Asterisk next to the project’s name and you will be asked if you want to 
discard the latest changes. 

• If you want to keep previous project configurations, be sure to rename the project before writing it to the 
controller. 

• Always change a project name via Save Project As in the K-CONFIG software. If the project name is changed 
outside the  
K-CONFIG software (for example, via the Rename function in a Windows folder view), it will not open correctly in 
K-CONFIG. 

4.2.1.3 Import/Export Controller Devices  

K-CONFIG lets you import or export device XML templates via the Import/Export Device feature in the File menu.  

This feature lets you import a newly released control device to the Control Room list (Master/Auxiliary) without having 
to upgrade the K-CONFIG. You can also share virtual device layouts that were created in K-CONFIG by exporting and 
importing them to other project files to be used in different room installations.  
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To Import a device: 

1. Select Import Devices in the File menu, and select the device (or devices) you want to import (only Kramer 
xml files will appear on the list). 
The following window appears: 

  
Figure 32: Import Devices 

2. Click Open. 
If the device already exists on your list, you will get the following message: 

 
Figure 33: Import Devices – Message 

Otherwise, the device will be added to the list. 

To export a device (virtual device only): 

1. Select Export Device in the File menu, and select the device you want to export. 
The following window appears: 

  
Figure 34: Select Virtual Device to Save  
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2. Click OK.  
The following window appears: 

 
Figure 35: Export Device xml File 

You can also export a virtual device by right clicking it and selecting Export Device XML: 

 
Figure 36: Export Device xml 

4.2.2 The Device Menu 

This section defines the Device menu. 

 

 
Figure 37: The Device Menu 

 

Menu Command Function 
Connect/ Disconnect Click to connect to a device via an IP address, a 

USB connector or a serial port (see Figure 38) or 
disconnect a connected device 

Discover  Discover devices in the local IP network 
Firmware Upgrade Load the firmware upgrade file to the device for 

upgrading the device (see Section  10.3). 
Sync Configuration to 
Device 

Writes the project configuration file to the device 
(active only when the device is connected), see 
Section  10.7 

Read Configuration 
from Device 

Reads the project configuration file (*.kpr) from the 
device (active only when the device is connected 
via Ethernet), see Section  10.7.1 

Clear Configuration 
from Device  

Removes the project configuration file from the 
device, see Section  10.9 
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Figure 38: The Connection Method Window 

 

Feature Function 
Connection 
Method  

Check to select connection to the device via the Ethernet, 
USB or Serial port 

Ethernet Area TCP/UDP: Check either the TCP or the UDP protocol 
 IP: Type the IP address of the device to which 

you want to connect 
 Port: Type the port number 
 Default: Click to reset the IP address to its default 

value 
Serial Port: Select the laptop serial communication port 
USB Area USB Device 

Drop box: 
Select the laptop USB communication USB 
port 

 Refresh Ports: Click to view the ports that are currently 
ready to connect on the Kramer device 

  

To connect to a Master device, select the master device (Figure 39), click the Connect button, select the connection 
method and fill in the relevant details (Figure 40): 

 
Figure 39: Connecting to a Master Device – Selecting the Device 

 

Figure 40: Connecting to a Master Device – Selecting the Connection Method 
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When connected, the Status displays the connection details: 

 
Figure 41: Connecting to a Master Device – the Connection Details 

Once connected, you can read the configuration from the device: 

 
Figure 42: Connecting to a Master Device – reading the Configuration 

4.2.3 The Windows Menu 

The Windows menu lists layout operations and all the available windows. Some of the windows (checked in the 
Windows menu) appear in the default layout. At any time you can add or delete a window from the main window layout 
and by clicking Default Layout you can return to the default layout. 

 
Figure 43: The Window Menu 

 

Menu Command Function 
Save Layout  Saves the current windows layout 
Load Layout Load a saved layout  
Default Layout Set to the default layout 
Save Layout on Exit Set to On to save 
Default 
layout 
windows 

Project Navigator Set the controlled room devices 
Triggers Arrange the triggers 
Action List Lists the actions added to the trigger 
Action Editor Select the actions to add to the trigger 
Device View Displays the selected device front panel 

Port Manager Click to open the Port Manager window 
Device Settings Click to open the Device Settings window see Section  10.4) 
Web Settings Click to open the Web Settings window (see Section  4.2.3.1) 
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4.2.3.1 Web Settings  

Web settings are used to set the Web page logo, room name and other details for Master room controllers that have 
an ETH port for remote access from a browser (and by that are also Site-CTRL compatible). Figure 44 shows the Web 
Settings window: 

 
Figure 44: Window Menu – Web Settings Window 

The logo file type can be either jpg, jpeg or png, up to 500 Kbytes in size.  

For best image quality, when viewed on the device’s Web pages, we recommend that you use images of H 200px and 
W 790px pixels. 

 

 
Kramer Site-CTRL is a powerful A/V assets management tool. It offers real-time monitoring and control of 
Kramer Master controllers installed in an A/V site and the A/V equipment connected to them. The Kramer  
Site-CTRL downloadable version can monitor and control up to 100 Kramer Master controllers. 

 

Kramer Site-CTRL: 

• Generates a single page summary of the entire installed A/V site. 

• Reports the communication status for each room. 

• Reports the status of the local controlled display devices. 

• Reports the remaining lamp life for the controlled projectors. 

• Supports easy access to the built-in Web pages of Master controllers via Web Access. 

• Raises alerts and sends e-mails when prompted by a user-defined special triggering event.  

4.2.4 The Help Menu 

 
Figure 45: Help Menu 

Select Check for updates to check for new updates. If a new update is found, the following message appears: 
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Figure 46: Help Menu – Check for Updates 

Select About to display the basic software and company details: 

    
Figure 47: The Help Menu – About K-CONFIG 

Click the Analytics icon to enable/disable the collection of data: 

  
Figure 48: The Help Menu – Enable Analytics 

Select User Manual or press the F1 button on your keyboard to open the latest version of the user guide. 
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4.3 Quick Access Icons 

The K-CONFIG main window includes a quick access and status toolbar, located just below the menus: 

 
Figure 49: The Quick Access Toolbar 

Quick Access Items Function 

 
Click to open a new project 

 
Click to open an existing project 

 
Click to save the current project 

 
Click to open the Driver Manager 

 
Click the button to connect to a selected room controller device 

 
Click to discover room controller devices on the network 

 
Shows the room controller device connection status  

 
Shows the size of the project.  
If the project exceeds the permissible size, a message will appear stating how to reduce its 
size (by not uploading the KPR file). In any case you will still be able to save the project (see 
Section  10.7.1) 

  
Click the button to sync the current configuration to the room controller device (after connecting 
it to the PC) 
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5 The Driver Manager – Getting Started 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

5.1 Getting to Know the Driver Manager 

Controlled AV devices (such as projectors, DVD players, switchers, scalers and so on) are controlled by sending out 
an appropriate command from the room controller to the controlled device, over serial, ETH or IR interfaces. A Driver 
is a collection of these commands which includes all the relevant commands for the specific device. 

When selecting “Driver Manager” from the file menu or the icon, the Drivers Tree window appears and you need to 
select a specific controlled device driver or to import a new driver. Once selected, the Driver Manager window 
appears.  

The Driver Manager has standard command names for different controlled devices by means of a shared-command-
name structure which can be used to build a standard command list. Each command type has a shared name that is 
common to controlled devices in the controlled room. 

A shared command can be either empty (only the name is on the list but it has no device command content), or full 
(the command has content); when the command is full, the command name on the list appears bold.  

The driver manager presents a list of standard shared command names. You can add a command name to the 
shared list. When adding a new command name to the shared sections of a driver – this command name will appear 
in every driver you will open in the future as an empty command name. This makes it easy to use the same command 
names in all your drivers.  

For example, if you have two types of projectors (made by different manufacturers) in the controlled room and each of 
them has its own specific communication protocol, they will most likely have different command names specified in 
their user manual for the same exact functional action. For example, the command name for powering up the 
projector can be named “PWR: ON” for the first projector and “Power: on” for the other one. The driver manager 
defines a common (or shared) name for both, “PWR_ON”, for the same type of command, while the content of the 
command (syntax) remains specific for each projector. 

 

 
Note that a command name cannot include spaces. Some command names, in former versions had spaces. 
For your convenience these command names will still appear with spaces. If you want to change these 
names via the Common Commands Tree Editor, you will not be able to rewrite them back to their original 
names (with spaces).  
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The Driver Manager window is actually a generic framework for managing the controlled room; it includes sets of 
standard command names (Shared) within the following categories: 

• Serial commands 

• IR Commands  

• Serial replies 

• Tables (Serial range commands) 

• Queries 

Each of the above categories contains sub-groups (depending on the device type) with command names that are 
“empty” for a new driver (a command name without any content): 

   
Figure 50: The Commands List in the Driver Manager 

A “Full” command name which includes syntax will appear Bold. An empty command name will appear as normal 
font. When selecting any of these “empty” command names you can see that the Command Syntax line is empty.  
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For example, when selecting PWR_ON: 

  
Figure 51: An Empty Command Line 

 

 
Note that when adding a command name to one of the shared sub categories (via the Common Commands 
Tree Editor, Section  5.3), this command name will be added to the Serial, IR and Serial Replies list and will 
appear as empty in all the drivers you will open for editing or as new from now on (you can delete this 
command also via the Common Commands Tree Editor). 

Each of the above categories also includes a Device-Specific sub-group. The Device-Specific sub-group is used for 
device specific command actions which are not used for other devices. Command names added to this section will 
not appear as empty command names in other drivers you will later open, since they are specific for this driver. 

When importing or opening an existing driver, the command names included in this driver are compared to the shared 
command names. Whenever a match between command names is found, the syntax associated with this command 
name will appear under the relevant shared command name. If a command name is not found in the Shared sections, 
it will appear in the Device-Specific section of this driver. 

For your convenience you can move the standard device specific commands (on, off, and so on) to the shared 
section of the driver. 

For example, in a certain driver the Power On function was previously tagged with the command name 
"POWER_ON". In the Driver Manager this command will be listed in the Device-Specific category as a non-shared 
command. Select this command for editing, and change the command name to “PWR_ON”. The command name 
changes and will move to the Shared section of this driver. 

This framework was structured to let you standardize the command names so that all the same command types will 
share the same command name although the specific command content is unique for each specific device.   
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5.1.1 Updating Command Names to the current version of K-CONFIG 
 

 
It is important that you carefully change the command names in this manner. If these commands are already 
used in an existing project that you may want to upload in the future to room control devices, you will need 
to update the command names in the project itself where they are used. 

 

If you want to add or delete command groups for the different 
controlled device types you can click the Edit Common Command 
Group icon ( ) and use the Common Commands Tree Editor to 
add or delete command groups for each controlled device type or 
create a custom made controlled device type (see Section   5.3). 

 

Furthermore, the Driver Manager lets you select the controlled device type (for example, a projector, DVD Player, 
audio amplifier and so on) so that the shared commands list displayed best fits the type of controlled device you are 
using. For example, it makes little sense to display Transport related commands for a Projector. It’s important to 
understand that the controlled device type selected only affects the displayed command sub groups, it has no “real” 
influence on the command tree – all shared commands still exist even if they are not displayed. You can also select a 
generic type so that all the possible commands are available (see item 2 in Figure 55). 

5.2 Selecting the Driver Manager 

To open the Driver Manager: 

1. In the File menu select Driver Manager. 

 

 
Figure 52: Selecting the Driver Manager in the File Menu 
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The Drivers Tree window appears: 

 
Figure 53: The Drivers Tree 

2. Select the driver you want to edit (a Sony Driver in this example):  

  
Figure 54: Selecting a Sony Driver 

3. Click Edit.  
The Driver Manager window appears. 
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Figure 55: The Driver Manager Window  

# Feature Function 
1 Drivers Tree Button Click to access the Drivers Tree window and select a different driver 
2 Driver Details  The Driver Details area displays the vendor, controlled device model and driver 

revision and date.  
Device Type – lets you select the typical controlled device type from a drop down 
list. Each device type relates to a set of command groups that are typical for that 
device type. For example, Selecting DVD Player as the controlled device type will 
include the Power, Transport, Image and Setup group commands  

3 Driver Settings: Serial Settings For serial connections, set the baud rate, data bits, parity and stop bits 
4 Driver Settings: Ethernet Settings  For Ethernet connections, set the IP address, port and protocol 
5 Create PDF Summary Button Click to create the driver summary see Figure 56 
6 Export Driver Button Export the driver setup 
7 Common Commands Tree Editor 

Button 
Set the common commands layout (see Section  5.3) 

8 Command Names List  Includes all the command types (Default / Non Default Shared and Device-
Specific)  

9 OK button Click to approve changes 
10 Cancel Button Click to cancel changes 
11 Apply Button Click to apply changes 
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Figure 56 shows an example of a PDF driver details summary document (for the Kramer VP-437xl): 

 
Figure 56: Driver Details Summary PDF File 
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5.3 The Common Commands Tree Editor  

Click the edit icon in the Command Names list to open the Common Commands Tree Editor. The Common 
Commands Tree Editor gives an overall view of the Device Types, Command Groups and Commands with regard 
to default/non-default shared driver commands, Tables and Queries and lets you make specific adjustments. 

 
Figure 57: Open the Common Commands Tree Editor 

5.3.1 IR, Serial and Replies 

Select IR, Serial and Replies to display the Device Types list, the Command Groups list and the Commands in 
each group. Figure 58 shows the IR, Serial and Replies Commands Editor. 

 
Figure 58: The Common Commands Tree Editor Window – IR, Serial and Replies  

# Feature Function 
Device Types The list includes commonly used controlled devices to choose from.  

Each controlled device type determines command groups that are available for the selected controlled 
device type (for example, Projector includes Power, Input, Volume, Image and Setup command groups 
while Audio Amplifier includes Power, Input, Volume and Setup command groups.  
You can rearrange the order of the controlled device type list using the up/down arrows, add a new 
Device Type, rename it or delete it. 

Command Groups Once you select the controlled device type, the relevant Command Groups are automatically checked.  
You can check a command group to add it to the controlled device type or uncheck it. You can add a 
new Command Group, delete it or rename it.  
You can also check or uncheck the entire command groups list. 

Commands Lists the standard commands included in command group. 
You can add a new Command Group (non-default shared), delete it or rename it. 

 

 

 
Note that K-CONFIG is supplied with a number of popular command groups and command names. These 
cannot be changed or deleted by the user. 



 

42 K-CONFIG - The Driver Manager – Getting Started 

 

5.3.2 Tables 

Tables shows the list of default shared tables (see Section  5.5.4 for a more detailed explanation). You can add a new 
non-default shared table name, delete it or rename it: 

 
Figure 59: The Common Commands Tree Editor Window – Tables 

5.3.3 Queries 

Queries shows the list of queries (see Section  5.5.5 for a more detailed explanation). You can add a new Query Name 
(non-default shared, for example, test1 on the list), delete it or rename it: 

 
Figure 60: The Common Commands Tree Editor Window – Queries 
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5.3.4 Adding Non-default Shared Commands 

Non-default shared commands can only be added via the Common Commands Tree Editor window. In the following 
example, a DVI command needs to be added to the Projector Input command group.  

To add this non-default shared command: 

1. Click the edit icon and select the Input command group: 

 
Figure 61: The Commands Tree Editor Window – Adding a Non-default Shared Command 

2. In the Commands list click the + icon. The following window appears: 

 
Figure 62: The Commands Tree Editor Window – Add Command Window 

3. Type the new command name and click OK: 

 
Figure 63: The Commands Tree Editor Window – Adding the Command Name 

 The new command was added to the Input Commands group and the DVI input device-specific command can 
be moved to the Input Commands list: 
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Figure 64: The Driver Manager Window – Non-Default Shared Command Added to the Input List 

 

 
Note that the non-default shared commands that were added will be part of the shared list for all the 
drivers. 

Repeat this procedure for Tables and Queries in the same way. Once you have completed this, you can configure the 
controlled room. 

5.4 Setting the Shared Commands 

The following section applies to Serial, IR, serial replies, tables and queries in the driver Manager window and 
describes how to move the content of a Device-Specific command to the shared commands list.  

To move the content of a Device-Specific command to the shared commands list: 

1. Select the Device Type (see Section  5.3.1). 
In this example a projector device type was detected 

  
Figure 65: The Driver Manager – Selecting the Device Type 
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 The Device Type narrows down the displayed list of serial command groups and includes only the ones that 
are relevant to a projector. 

 The shared commands list default/non-default command names that are currently "empty" (see Section  5.3.1). 

2. Select the Device-Specific command in the Power Command Group. 

3. Click and drag the "Power: Off" command to the shared PWR_OFF command. 

 
Figure 66: The Driver Manager – Dragging the PWR_OFF to the Power Command Group 

The following message appears: 

 
Figure 67: The Driver Manager – Action Copy Message 

4. Click OK. 
In the Power commands group, PWR_OFF appears bold (it's not "empty"). 

  
Figure 68: The Driver Manager –PWR_OFF added to the Power Command Group 
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5. In the same way you can move the content of other Device-Specific commands and fit them into the relevant 
command groups: 

 Select the Device-Specific command name. 

 Click and hold that command. 

 Drag the command to the desired command in the shared list.  

 Click the Action Copy message OK. 

Upon completion of this procedure, the "live (with command content)" command groups and commands appear bold 
in the list. Commands that are unique to the controlled device remain in the Device-Specific command list, see Figure 
69. 

 
Figure 69: The Driver Manager – Standard Commands Added 

5.5 Serial Commands 

Select a serial command (Shared or Device-Specific). The following window appears: 

 
Figure 70: Serial Commands  

The area on the right shows the command name and command syntax. You can display the syntax as Hex, Decimal or 
ASCII. To move a Device-Specific command to the Shared list, see Section  5.4. 

Once the controlled device is connected you can test the command, as described in Section  5.5.1. 
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5.5.1 Creating a Serial Device-Specific Command 

To add a serial device-specific command: 

1. In the Serial list, select Device-Specific and click the + icon 

The following window appears: 

 
Figure 71: Serial Commands –Add New Command Name 

2. Type the new command name (for example, DVI_IN) and click OK:  

 
Figure 72: Serial Commands – the New Command Name 

3. In the Driver Manager window select the new command (DVI_IN): 

 
Figure 73: Serial Commands –Selecting the New Command Name 
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4. Type the command and click the Set button: 

 
Figure 74: Serial Commands – New Command Added 

 The DVI_IN command was added to the commands device-specific list and appears bold. 
 

 
Note that when writing a serial command: 

-  if you enter ASCII commands, enclose the strings in quotation marks (for example, "MUTE OFF"). 

-  Prefix the hex characters with 0x or "$" (for example, 0x0D), non-prefixed values are in decimal  
   (for example, 13). 

-  String and byte values should be separated by commas or spaces (for example,  
   "BRIGHT DEC",0x0D). 

-  If a protocol command states Carriage Return (<CR>) and/or Line Feed (<LF>) following the 
   command line, add 0x0D or 0x0A, respectively, outside the command quotation marks, separated by 
   a comma.  
   For example, “PWR” <CR> <LF> should appear as “PWR”,0x0D,0x0A. 

If required, you can test the command  

1. If the room control device is not physically connected, connect it now and connect the controlled device (for 
example, a DVD or projector). 

2. In the Driver Manager window select the command to be tested. 
The command syntax appears in the text box on the top right area (under Command Name). 
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3. Click the Test Command button: 

 If the connection type between the room 
controller device and the PC was not yet 
established, the connection window will 
appear and you should select the connection 
method (in this specific example, the  
RC-74DL is connected to the PC via the 
Ethernet) and click Connect (see Figure 75) 
after that the Device Ports window appears 
(see Figure 76). 

 

  
Figure 75: Testing Serial Commands –Connecting the PC to 
the Room Controller 

 

 If the room controller device is connected, the 
Device Ports window appears and you will 
need to select the port to which the controlled 
device is connected (see Figure 76). 

 

  
Figure 76: Testing Serial Commands –Selecting a Device Port 

4. Select the port to which the controlled device is connected to the room controller (for example, the projector is 
connected via RS-232 Terminal Block 1 to the RC-74DL room controller) and click OK.  

 Note that if the controlled device is connected to the Ethernet, the following window appears. Verify the details 
and then click OK. 

 
Figure 77: Testing Serial Commands –Ethernet Settings for Controlled Device 
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The command tested is sent to the controlled device. The Request text box shows the sent command and the 
Response text box shows the response: 

 
Figure 78: Testing Serial Commands – Setting the Command 

Click the Test Command and wait for the response. 

 
Figure 79: Testing Serial Commands – Request and Response 

If the controlled device fails to respond, an ERROR or TIMEOUT message appears. 

If the reply has not yet been written to Serial Replies syntax (see Figure 81) or if it does not match the current reply 
defined in Serial Reply, the following message appears:  

 
Figure 80: Testing Serial Commands – Storing the Reply 

Click OK to store the reply. 
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Figure 81: Testing Serial Commands – Serial Reply Stored 

If the response matches the current Serial Reply, you will get the Reply Stored Message. Click OK. 

 
Figure 82: Testing Serial Commands – Serial Reply Matches Stored Reply 

5.5.2 Creating an IR Command 

Open the IR command list and select a command. You can add an IR command by: 

• Typing in the command syntax (see Section  5.5.1). 

• Adding a controlled device’s pronto IR code and converting it to the regular syntax. 

• Reading the IR command via IR Learning as described in this section. 

Converting the Pronto IR Codes 

Controlled devices which do not have Pronto IR codes require that you convert them before they can be used in  
K-CONFIG. 

In the following example, to convert the PWR_ON IR code of a Sony Projector: 

1. Select the required command (PWR_ON), click the Convert from Pronto button. 
The CONVERT PRONTO COMMAND window appears. 
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2. Copy the IR Pronto code for the specific machine command (without the quotation marks) and paste it into the 
CONVERT PRONTO COMMAND window: 

 
Figure 83: IR Commands – Convert Pronto Command Window  

3. Click OK. 
The command has been converted: 

 
Figure 84: IR Commands – Pronto Command Converted 

Reading the IR Command via IR Learning 

To create IR commands for a selected device, connect the room controller device (with IR learning capability) directly, 
whether it is defined as an auxiliary device or a Master device, to your PC and use the remote control transmitter to 
learn its IR commands. 
Use the remote control transmitter of the machine from which you want to learn the IR commands. For example, use the DVD 
remote control transmitter to write the DVD commands to the driver manager.  

To create an IR command: 

1. Connect the room controller device directly to your PC. 

2. Select an IR command (HDMI_1 in this example) 
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If you are creating a controlled device specific command, select IR>Device-Specific and click + to add a 
command. The following window appears: 

 

Type the new command’s name and click OK. 
The new command is added to the Device-Specific list. 

3. Click the Read Command or the Connect button. 
The Connection Method window appears. 
If you choose to click the connect button, once connected you will have to click the Read Command button. 

  

Figure 85: IR Commands - Connect to the Room Controller Device 

4. Click Connect. 

5. Click the Read Command button. 
The following window appears. 

 

6. Click OK. 
After clicking this button, you have a 1 minute period to point the remote control to the IR learner sensor to let 
it capture the command. 
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Figure 86: IR Commands – The device is Connected 

 

 
We recommend that you perform IR learning with minimum lights on and within proximity of 3 to 5cm 
from the sensor. Any other light source may distort the IR command obtained (as in the example in 
Figure 87). 

7. Click the IR remote towards the IR sensor until the command string is obtained: 

 
Figure 87: IR Commands – The IR command String Obtained 

8. Click Set to save the command. 
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9. Select the IR port to which the command will be assigned: 

 
Figure 88: IR Commands – Selecting a Room Controller Device IR Port 

You can test the IR command by connecting the room controller device IR terminal block connectors to the controlled 
device via the IR emitter port, and then clicking the Test Command button. 

 

 
Note that if the room controller device is connected via USB or a serial port and the length of the command 
is longer than 47 bytes, you will not be able to test it (this does not mean that the command itself will not 
function directly from the room controller device). 

Figure 89 shows how to connect the IR emitter port cable (using the Kramer 3.5mm to IR Emitter Control Cable (C-
A35/IRE-10)). The white striped side connects to IR OUT, the black side connects to the Ground, and the LED Emitter 
Shell is affixed to the IR sensor window with the adhesive layer. 

 
Figure 89: IR Emitter Wiring 

 

 
We recommend that you do not use the dual IR emitter since it emits a weaker IR signal that may not be 
detected by some controlled devices. 

5.5.3 Creating a Serial Reply  

When sending a serial command to a device, that device will usually send a reply. This reply can be used to create 
monitor events. Serial replies can be typed manually or by sending a serial command to the device and obtaining its 
reply.  

To add a serial reply: 

1. Select a command for which there is a command string in the serial command, for example PWR_OFF. 

2. In Serial Reply, select PWR_OFF from the shared list: 
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Figure 90: Serial Reply Commands – Selecting a Serial Reply Command 

3. Connect the room controller device to your PC. 

4. Click the test command button. 
The Connection Method window opens. 

5. Click Connect. 

6. Click the Select Port button, select the relevant serial port and click the Select Port button. 

7. Click Test Command 
The reply appears in the command syntax area: 

 
Figure 91: Serial Reply Commands – Reading the Serial Reply Command 

8. Click Set. 
The Serial Reply was added to the shared Serial Reply>Power list. 

 

 
Note that a serial reply can be created by testing a serial command and storing the response (see 
Section  5.5.1). 
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5.5.4 Creating a Table List 

It is useful to write multiple serial commands to a table if they include an adjustment range (for example, the volume 
level data ranges from 0 to 64). The Table Commands table includes a list of indexed serial commands in sequence 
(the line number) that the controller should send out once reaching this line. 

In the action lists, the program configurator will be able to jump to a certain line (useful on device startup to specify the 
line to use as the startup state), move up one line and move down on line. These options make it very easy to control 
range based AV settings (volume, brightness and so on). 

The three actions associated with the Table structure can be part of any action list - turn of a volume knob on a room 
controller device or any button on a room controller device or even a timer trigger. The Table also lets you link the 
volume LEDs to the range level. 

For example, driver commands that define the volume level (from 0 to 64) can be inserted in the Table area in the Driver 
Manager window. The table is then included in a trigger that lets you change the volume level to a set value with each 
press of a button or turn of the knob (for digital audio). 

Tables can be default/non-default shared or device-specific. Non-default shared tables are added via the Commands 
Hierarchy table. Device-specific commands are added via the Driver Manager window. 

To setup a Table: 

1. In the Driver Manager window, select a Tables command (for example, Volume): 

   
Figure 92: The Driver Manager Window – New Table 

The Driver Table window lets you: 

 Select the number of commands (rows) in the table (up to 300) 

 Write and display the command string in Hex, Decimal or ASCII formats 

 Auto Select the relevant rows  

 Set the LED Level 
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2. Select the number of rows you need (for the volume adjustment example, 14 rows are recommended): 

 
Figure 93: The Driver Manager Window – Select Number of Rows 

You can set the Min and Max Index (up to 13 in this example) which will slice out a section of the commands that will 
be used. 

 

 

Note that if you find that you have not selected the exact number of rows, you can add or delete a row at 
any time. 

3. Enter the command data according to the protocol: 
 

 
For example, a certain LCD Display command format is: 
[Command1][Command2][ ][Set ID][ ][Data][CR] 
Data ranges from 0 to 64. 
The specific command for the Volume Control (for a Data value of 35) is: 
[k][f][ ][Set ID][ ][Data][Cr]: “kf 1 ”,0x35,0x0D. 

4. Click the Command Data area and type the command into the driver table: 

   
Figure 94: The Driver Manager Window – Typing Commands 
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5. Add the following commands (you can use the copy and paste function between the rows and just change the 
specific, relevant byte): 

   
Figure 95: The Driver Manager Window – Writing the Commands 

Upon creation, by default, all the rows are checked – meaning that when you move UP/DOWN the list, all the rows will 
be used. If you prefer to use less rows in your configuration (for example, you may not need to use all the volume 
levels to create a clean volume UP/DN effect) you can now enable or disable specific row commands manually or 
through the “Select Every” box, as needed (for example, to set the rate of increase or decrease of the volume) by 
selecting which commands should be used when traveling UP/DN in the table with the relevant K-CONFIG Action 
commands: 

6. For example, select every 3 rows and click Set: 

 
Figure 96: The Driver Manager Window – Selecting every 3 Rows 

7. Check the Keep current selection box if required. 



 

60 K-CONFIG - The Driver Manager – Getting Started 

 

You can also do this logarithmically, for example, to increase the volume at a fast rate in the lower range and slower in 
the higher range: 

• Check Logarithmic. 

• Select the approximate number of steps you need (the table calculates the optimal number).  

• Click the Set button. 

 
Figure 97: The Driver Manager Window – Logarithmic Row Selection 

8. Set the LED Level: 

 
Figure 98: The Driver Manager Window – Setting the LED Levels 

 The Levels indicate the number of digital knob LEDs that light for each data command on relevant room 
controller devices (for example, the RC-63DL or RC-54DL). You can set the LEDs to light only in sequence. 
For example, one LED will light for data commands up to 30. Two LEDs will light up to data command 50, and 
so on. 
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Note that when selecting a command, the test command area appears, letting you test each command in the 
table. 

9. When the table is complete, click the Apply Table Changes button and then click OK. 
The Volume Table name appears bold now. 

 

 
You can create several sets of tables for different commands. 

Once the table is ready, you can use the commands table to set the volume to an exact value in a trigger 
(see Section  9.2.1). 

5.5.5 Creating a Query 

A query is a question sent from K-CONFIG configured program to a controlled device followed by an expected reply 
from that device. The reply is analyzed by the controller program according to a set of definitions that was configured 
by the user or by receiving the first reply within a predefined time period. The reply can then be used to trigger a list of 
actions. 

You can build the query into a shared Query name (Power, LampHour, Fan, Comm_Status and Input), or create 
Device-Specific queries. 

Queries are sent to the Kramer Site-CTL software which can monitor and control multiple room controllers via the Site 
Control Message command (see Section  9.11). 

 
Figure 99: The Driver Manager Window – The Query 

To define a shared query, for example, a projector’s lamp hours: 

1. Under Queries, select Shared and then LampHour. 
The Query area appears: 
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` 

Figure 100: The Driver Manager Window – The Shared Query 

Fill in the Query LampHour Details: 

Feature Function 
Command Syntax Type in the query in HEX/Decimal/ASCII format according to the protocol of the specific 

projector 
Select response Parse if message from device contains a certain syntax or Parse if the message arrives within a 

certain time period 
 Parse if message from device contains: to ensure that the system will parse only the relevant 

serial replies from the controlled device, type in the syntax that will always be included in the 
reply. 
For example, the lamp hour response should always include: #LMP_HR” 
Parse if message arrives in time: the system will accept the first message received within the 
predefined time period. This can be used when the response cannot be defined by content   

Parse Reply Check Parse Reply if you want the system extract relevant information (text, number and so on) 
from the complete serial reply 

 Begin in Byte: Set the byte from which the relevant information starts: to start with the 
first byte, select, to start from the second byte, select 2, and so on. 
The number selected can be considered as the number (characters that 
should be ignored: 1) from the beginning of the response. 

 End Parsing by: End of Reply: the information ends with the final character in the packet. 
Specific Char: a certain character will define the end of the information 
bits (for example, “A”). 
Counting Bytes: the response will always have a set number of 
characters. 

 Stop Value: Type in the characters that define the end of the response. 
Answer Format Select the answer format according to the device protocol format: 

Text (the answer appears as text) 
Number as Text [“4567”] 
Hex number as Text [“11D7”] 
Number – Bytes value (Highest value in first byte – 0x11,0xD7) 
Number – Bytes value (Highest value in last byte – 0xD7,0x11) 

Response Units The response units for all answer formats except Text: 
Hours/None 
Minutes [will be divided by 60 to get Hours] 
Seconds [will be divided by 36000 to get Hours] 

Response definition 
table 

This table defines the response ranges and their names.  
Result Name The result name will appear when the command data in the query reply 

complies to the condition stated.   
 Operator The operator is the condition and is set according to the answer format.  

For example, if the answer format is text, the Operator will be “= Equal 
To”.  
Other answer formats have the following operators: </> Not Equal To, > 
greater than, < Less Than, >= Greater Than or Equal To, <= Less Than 
or Equal To, >< Between. 

 Command Data The Command Data is the part of the data that represents the condition. 
Max Lamp Hour Set the maximum lamp hours (according to the projector manufacturer's data sheet. 
Clear Clear the table. 
Apply Query 
Changes 

Save the table data (see Figure 101). 
Once the table is saved, the text command area appears: 
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Feature Function 
Testing the 
command 

 
To test the command, connect to the machine and select the port. The command syntax 
appears automatically in the Request line. Click the Test Command button and check that the 
response complies with the answer format.  

Parse by Query 
Rules 

After receiving the device's response, the "Parse by Query Rules” button appears: 

 
You can click the button to test the parsing rule against the reply and see if it gives the expected 
result and select the correct result from the table. 

Figure 101 shows the Query LampHour Details: 

 
Figure 101: The LampHour Query Details 

The query can then be used to create query events (see Section  8.6). 
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6 Defining the Control Room via the Project Navigator 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

Once you have arranged and defined the driver commands of the controlled devices, you can set the control room via 
the project navigator. 

The project navigator lets you set the controlled room.  

Depending on the Master room controller, up to four Aux K-NET devices and two Virtual Devices as well as up to 15 
control gateways can be used in the same control system setup. At any point you can-right click a room controller 
device to perform further functions. 

You can check the Show unused ports box to show the ports that are unused for each device. 
 

 
We recommend that you open a new project before defining the control room. At any point, you can save (or 
save as) the project, see Section  4.2.1. 

When opening a new project, you can either add a Master Room Controller or a Virtual Master. The Virtual Master is 
used for controlling rooms via KRAMER NETWORK (see our Web site at http://www.kramerav.com/NETWORK). 
KRAMER NETWORK Virtual Master is described in detail in Section  12 

6.1 Adding a Master Room Controller 

In the following example the RC-74DL is selected as the Master room controller and the RC-63DL is the connected 
auxiliary device (some of the devices in the Add Device list (for example, the WP-500) do not accept auxiliary devices). 
Figure 102 shows the Project Navigator window. You can right-click the Control Room label to rename it or add a 
Master Device.  

   
Figure 102: The Project Navigator Window 

http://www.kramerav.com/NETWORK
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To define the devices via the Project Navigator: 

1. In the Project Navigator window area, click + to add a device to the tree. 
The Add Master Device window appears. Scroll down and select RC-74DL: 

  
Figure 103: Adding a Master Device to the Project Navigator Window 

2. Click OK. 
The main window appears and reflects the selection of RC-74DL: 

 
Figure 104: Main Window – Master Device Selected 
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In the main window you can check the Show unused ports box to show the list of the unused ports of the Master 
controller: 

 
Figure 105: Main Window – Show Unused Ports 

Once ports are assigned to controlled devices the used ports will appear on the list (see Section  7). 

The Port Manager window (which does not appear in the default layout) lists the RC-74DL relevant ports (see Figure 
106): 

   
Figure 106: The Port Manager Window for RC-74DL 
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3. Select the Master device (1 – RC-74DL) and Click + again.  

  
Figure 107: The Auxiliary Device Window 

You can filter the controller device names by typing any part of the name in the text box on the right (same for virtual 
devices). For example, typing 53 will filter all the devices with 53 in their name: 

        
Figure 108: Filtering the Controller Device Name 
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You can add: 

• Room controllers and control panels (see Section  6.2) 

• A control gateway device (see Section  6.3) 

• A virtual device (see Section  6.4) 

• Virtual device templates (see Section  6.4.5) 

6.1.1 Master Device Shortcuts 

You can right-click the Master Room Controller line in the Project Navigator area to perform various operations for 
different master controller devices. This section shows different examples of operations that are available for various 
master controllers. 

6.1.1.1 RC-74DL Example 

Right click an RC-74DL Master Device to: 

• Add an auxiliary device (opens the ADD AUXILIARY DEVICE window) 

• Delete the master controller device together with auxiliary devices 

• Add a description of the master controller device, which will appear as the title of the Port Manager window 

• Set a K-NET ID to the device (see Section  10.2) 

 
Figure 109: Master Controller Device Shortcuts – Example 1 

6.1.1.2 SL-14RN Example 

Right click an SL-14RN Master Device to: 

• Add an auxiliary device (opens the ADD AUXILIARY DEVICE window) 

• Delete the master controller device together with auxiliary devices 

• Add a description of the master controller device 

 
Figure 110: Master Controller Device Shortcuts – Example 2 



 

K-CONFIG – Defining the Control Room via the Project Navigator 69 

 

6.1.1.3 RC-13TC Master Room Controller Example 

Right click an RC-13TC Master Device to: 

• Add an auxiliary device (opens the ADD AUXILIARY DEVICE window) 

• Delete the master controller device together with auxiliary devices 

• Add a description of the master room controller device 

• Set a K-NET ID to the master room controller device (see Section  10.2) 

• Set Automatic behavior (see Set Automatic Behavior below) 

 
Figure 111: Master Room Controller Device Shortcuts – Example 3 

Set Automatic Behavior 

The RC-13TC Video Transport controller panel buttons receive actions automatically, according to their button names. 
 

 
Before setting the RC-13TC to automatic behavior we recommend that you prepare the drivers via the driver 
manager (see Section  5). 

To set to automatic behavior: 

1. Right-click Set Automatic Behavior. 
The following message appears: 

 
Figure 112: Set Automatic Behavior – Message 

 

 

Note that if you have already assigned the drivers, the wizard will open immediately (see Figure 115). 

2. Click OK. 

3. In the Port Manager window, assign the drivers to the port (see Section  7) as shown in the example in  
Figure 113. Each time you add a driver you will get a message referring to the automatic behavior setup. 
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Figure 113: Set Automatic Behavior – Port Manager Example 

4. Once the drivers are assigned you can close the Port Manager window. 
The Project Navigator now lists the assigned ports. 

 
Figure 114: Set Automatic Behavior – RC-13TC with Assigned Ports 

5. Right-click the RC-13TC line in the Project Navigator and select Set Automatic Behavior. 
The following window appears: 

 
Figure 115: Set Automatic Behavior – Device Transport Commands Wizard Window 

6. Click OK. 

When setting the Keypad Events Trigger (see Section  8.2) the triggers and actions related to the assigned drivers 
appear automatically with regard to the buttons on the RC-13TC. 
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6.2 Adding Room Controllers 

Auxiliary devices or keypad devices are added from the top list of the ADD AUXILIARY DEVICE window.  

To add a room controller: 

1. Select the auxiliary device (for example, RC-63DLN) and click OK.  
You can also add the auxiliary device by right-clicking the Master Room Controller label, RC-74DL in this 
example.  
The RC-63DLN front panel appears in the Device View area: 

 
Figure 116: The Device View Area for RC-74DL and RC-63DLN 

2. In the Project Navigator area, select 1 - RC-74DL. 
It is necessary to select the Master room controller to add an additional device 

3. Click +. 

4. Select another device from the list (for example, the SL-12).  
 

 
To add additional auxiliary devices to the list (depending on the Master room controller selected, up to four 
Aux K-NET control devices), repeat the above steps. 
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All four keypad devices that were added in this example appear in the in the Device view: 

 
Figure 117: The Device View Area for RC-74DL and Four Auxiliary Devices 

 

 
Be sure that your control room setup tree is correct before continuing with the configuration. If, at a later 
stage, an auxiliary K-NET device or a Master RC will be deleted from the tree, all the port assignments, 
triggers and action lists written for all the devices in the tree will also be deleted. 

6.2.1 Auxiliary Device Shortcuts 

You can right-click the auxiliary device line in the Project Navigator area to carry out several operations which can vary 
for different devices. This section shows different examples of operations that are available for auxiliary devices. 

Generally the shortcuts let you: 

• Delete the auxiliary device 

• Add a description of the auxiliary device  

• Set a K-NET ID to the auxiliary device (see Section  10.2) 

• Upgrade the firmware (see Section  10.3) 

 
Figure 118: Auxiliary Master Device Shortcuts 
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The following sections describe additional shortcuts for specific auxiliary devices. 

6.2.1.1 Several Identical Devices Installed 

When several identical auxiliary devices are installed in a controlled room, you can set one or more of them to be the 
exact same as the other auxiliary device. 

For example, three RC-63DLN units are installed in the controlled room. One can be set to act in the same manner as 
the other: 

 
Figure 119: Auxiliary Device Shortcuts – Set the Same As 

6.2.1.2 RC-3TBU Example 

The Kramer RC-3TBU remote control panel replicates any 3 buttons of the Kramer SL-14RC/SL-14RCN.  
The RC-3TBU can be connected only to the SL-14RC/N, and you can set the 3 RC-3TBU buttons to copy any 3 
buttons of the SL-14RC/N via the auxiliary device shortcut.  

To do so, click Configure Switch Buttons:  

 
Figure 120: Auxiliary Device Shortcuts – Configure Switch Buttons for RC-3TBU 

The following window appears: 

 
Figure 121: Auxiliary Device Shortcuts – Connect the Device to your PC 



 

74 K-CONFIG - Defining the Control Room via the Project Navigator 

 

Set the connection type: 

 
Figure 122: Auxiliary Device Shortcuts – Set the Connection Method 

Click Connect. 

If you did not select the default drivers, the following message appears: 

 
Figure 123: Auxiliary Device Shortcuts – Selecting Default Drivers 

Connect the RC-3TBU to the PC via USB, select the connection port and click the Connect button. The following 
window appears: 

 
Figure 124: Auxiliary Device Shortcuts – Configuring RC-3TBU Buttons 

Select the SL-14RC buttons you want to copy and click OK. 
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6.2.1.3 RC-13TC Auxiliary Device Automatic Behavior Setup 

Right-click an RC-13TC Auxiliary device to set the automatic behavior of the device (see Section  6.2.1.3 for further 
details): 

 
Figure 125: Auxiliary Device Shortcuts – Setting Automatic Behavior 

6.3 Adding a Control Gateway Device 

The Kramer control gateway devices let you expand the number of ports used to connect to the controlled devices (for 
example, the FC-132ETH with 32 serial ports, the FC-22ETH with two RS-232 ports, the FC-28 with two RS-232 ports, 
four IR ports, two relay ports and two GPI/O ports, and so on). 

  

 
Note that only master controllers that have an Ethernet port can accept I/O proxy devices. 

To add a control gateway device (for example, the FC-26): 

1. Click Add Auxiliary Device. The following window appears: 

 

Figure 126: Adding a Control Gateway Device 
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2. Click OK. FC-26 appears in the Project Navigator window as follows: 

 
Figure 127: Control Gateway device – FC-26 Listed in the Project Navigator 

Adding the control gateway adds additional ports through which you can send commands to devices. For example, the 
FC-26 when connected to the RC-74DL via the Ethernet port, adds four more IR OUT ports and two more RS-232 
ports to the system. So the RC-74DL can actually control two RS−232 and four IR controllable devices via the 
Ethernet connection. 

These ports are defined in the Port Manager of the Master controller (RC-74DL in this example).  

Once a control gateway device is added to the system, you can open the Port Manager Window to assign each of the 
FC-26 ports to an Ethernet port in the RC-74DL. 

Figure 128 shows the RC-74DL Port Manager after adding the FC-26 Device: 

 
Figure 128: Control Gateway Device – Port Manager Window 

  

 
Note that 15 Ethernet ports are added when the master device is a physical master room controller device 
and 50 Ethernet ports are added for a Virtual room controller device (see Section  12). 
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To set the ports: 

1. Select an Ethernet port (Ethernet 11, for example) and click Select proxy (gateway) in the Driver column of the 
port manager window.  
You can also select an Ethernet port by checking the Show unused buttons box and then right-clicking that 
port in the Project Navigator window: 

 
Figure 129: Control Gateway Device – Proxy (Gateway) Port 

The following window appears: 

 
Figure 130: Control Gateway Device – Proxy (Gateway) Ports List  

2. Select a port (you can select one or more ports, see Section  6.3.1), for example IR.Out_2: 

  
Figure 131: Control Gateway Device – Select a Port 

 Note that if a port has already been assigned with a driver (VP-444 is assigned to IR OUT 1 in the example 
above), that port will display the driver name and you can also choose it as a gateway port). 
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3. Click OK. Ethernet.11 port is assigned: 

 
Figure 132: Control Gateway Device – Select a Port 

 

 
Note that you can either assign a Control Gateway port or a regular driver to the Ethernet port on the 
master controller. If at this stage you decide to select a driver it will run over the gateway port.  

4. Click the UDP, 0.0.0.0 in the Properties column. The following window appears: 

  
Figure 133: Control Gateway Device – Ethernet Settings for IR Port 

5. Select the Protocol type set the IP number, and the port number as defined in the FC-26 Web pages (see 
Figure 134, for example): 

 
Figure 134: Control Gateway Device – FC-26 Communication Web Page 
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6. Copy the Ethernet settings: 

 
Figure 135: Control Gateway Device – IR Port Ethernet Settings 

7. Click OK.  
The IR.Out_1 port is now assigned to Ethernet.11: 

 
Figure 136: Control Gateway Device – Port Manager, assigning an Ethernet Port 

In the same way you can assign all the IR Out ports each to an Ethernet port: 

 
Figure 137: Control Gateway Device – Assigning all the IR ports 
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To assign the RS-232 port to an RC-74DL port: 

1. Click Select Proxy (Gateway), and fill in the details from the FC-26 Web page (see Figure 139). 

 
Figure 138: Control Gateway Device – Select Proxy (Gateway) Port 

2. In the FC-26 Web page select the correct IP port and fill in the details. 

 
Figure 139: Control Gateway Device – FC-26 Serial Port Settings Web page 

3. Fill in the details: 

 
Figure 140: Control Gateway Device – RS-232 Port Ethernet Settings 
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The Port Manager shows the RS-232 port assigned to Ethernet.5: 

 

In the FC-26 Port manager you can assign the controlled device drivers to which the ports will be connected (for 
example, VSM-4x4HFS is connected to FC-26 via the RS-232_2 port): 

 
Figure 141: Control Gateway Device – FC-26 Port Manager 

 

 
The difference between a control gateway device and a regular auxiliary device is that the control gateway is 
connected via an Ethernet port, which lets you control controlled devices from a distance (the FC-26 does 
not have to be located close to the master room controller device) and you can use one of the virtual 
Ethernet ports so as not to “waste” a physical port on the Master room controller device. 

6.3.1 Selecting Multiple Control Gateway Ports 

When selecting a control gateway port you can select one RS-232 port per Ethernet virtual port or more than one IR 
port, relay port and GPI/O port. 

In the following example, two control gateways are connected to the RC-74DL: FC-28 and FC-26. To assign control 
gateways to a virtual Ethernet port, check the Show unused ports box in the Project Navigator window and then right-
click that port (for example, RC-74L Ethernet Port 6): 

 
Figure 142: Multiple Control Gateways – Selecting the Virtual Ethernet Port 
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Click Select Proxy. The Proxy Ports window appears: 

 
Figure 143: Multiple Control Gateway Ports – The Proxy (Gateway) Ports Window 

Click a port to select it and click again to deselect it. 

Note that: 

You can select either one RS-232 port or any number of other port types. If an RS-232 port is selected, selecting any 
other port will deselect that RS-232 port. 

      
Figure 144: Multiple Control Gateway Ports – Selecting Different Proxy (Gateway) Port Types 
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You can select the ports of only one control gateway per Virtual Ethernet port: When ports are selected from one 
control gateway, selecting a port from another control gateway will deselect them: 

      
Figure 145: Multiple Control Gateway Ports – Proxy Ports Selected per Control Gateway 

After selecting multiple ports click OK. The list of control gateway ports appears next to Virtual Ethernet port 6 in the 
Project Navigator window (to edit the list, right-click that line): 

 
Figure 146: Multiple Control Gateway Ports – Selected Proxy (Gateway) Ports in Project Navigator Window 

The Port Manager window shows the proxy ports list as follows: 

 
Figure 147: Multiple Control Gateway Ports – Selected Proxy (Gateway) Ports in the Port Manager Window 

Click the proxy (gateway) list to edit it.  



 

84 K-CONFIG - Defining the Control Room via the Project Navigator 

 

6.3.2 Control Gateway Device Shortcuts 

You can right-click the control gateway device line in the Project Navigator area to perform various operations for 
different control gateway devices. This section shows different examples of operations that are available for auxiliary 
devices. 

Generally the shortcuts let you: 

• Delete the device 

• Add a description of the device  

• Upgrade the firmware (see Section  10.3) 

 
Figure 148: Control Gateway Device Shortcuts 

• Right-clicking also lets you delete the master room controller device and auxiliary devices, add a description and 
set the K-NET™ ID. 

6.4 The Virtual Device  
 

 
The virtual keypad device is compatible with master room controllers with ETH port and which can accept 
auxiliary devices. 

To support the virtual keypad device application, a Virtual Device triggers program layer must be defined by  
K-CONFIG (see Figure 149).  

 
Figure 149: Adding a Virtual Device 
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This program layer will associate triggers sent from the virtual keypad UI application to the Master room controller for 
triggering the program-configured series of control actions. Once you have created a virtual keypad device layout, it 
can be shared using the Import/Export XML function under the File menu. 

After adding a Virtual Device to the room control tree (you can add up to two virtual devices, as determined by the 
Master room controller), the keypad area shows the basic Virtual Device panel, that includes 12 buttons and three 
configurable text labels: 

 
Figure 150: The Basic Virtual Device Front Panel 

6.4.1 Edit the Device View 

Right-click the virtual device icon in the Project Navigator area and select Edit Device View to open the VIRTUAL 
DEVICE PROPERTIES window (see Figure 151). 

 

Figure 151: The Virtual Device Properties Window 

The VIRTUAL DEVICE PROPERTIES window lets you: 

• Add up to 128 buttons.  

• Add knobs 

• Add frames 

• Add up to 32 active configurable text labels. 

• Create up to six virtual panels (recommended).  

• Set the position and size of buttons and labels. 

• Keep track of the virtual keypad device versions by setting the version number. This helps keep track of the 
version, especially when exporting a virtual device. 
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• Save the virtual device as an XML file so that the labels on the buttons and text labels are saved even if their 
view is edited. 

You can, at any time, delete buttons, text labels and panels. 

For example, you can define the virtual keypad device layout as illustrated in Figure 152: 

 
Figure 152: Custom Virtual Device Appearance in K-CONFIG 

To define the virtual device front panel, as illustrated in Figure 152 (you do not have to follow the subsequent steps in 
the same order): 

1. In the VIRTUAL DEVICE PROPERTIES window, delete buttons 4 to 12, labels 2 and 3, as illustrated in Figure 
153: 

 
Figure 153: Editing the Virtual Device (Step 1) 

2. Add a knob and frame and then set the size of the panel, the size of the buttons, the text label size and their 
position (set the position by selecting and dragging the item), as well as the virtual keypad device Name (see 
Figure 154): 
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Figure 154: Editing the Virtual Keypad Device (Step 2) 

3. Type the virtual keypad device name and click the: 

 OK button, if you want to save the device XML in this project only. 

 Overwrite Xml button, if you want to save the device XML in the Virtual Devices directory. 

The Virtual Device appears in the Device View window (see Figure 155): 

 
Figure 155: The “DVD Controller” Virtual Device Front Panel 

4. Right-click a text label or button to set its name (see Figure 159): 

 
Figure 156: Setting the LCD and Button Label Names 



 

88 K-CONFIG - Defining the Control Room via the Project Navigator 

 

5. Right-click a button to set its behavior (see Figure 159): 

  
Figure 157: Setting the Button Behavior 

Set the Volume knob Function: 

 
Figure 158: Setting the Knob Function 

Figure 159 illustrates the final appearance of the virtual device: 

 
Figure 159: Final Appearance of the “Room 1” Virtual Device Front Panel in K-CONFIG 
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6.4.2 Creating and Inserting Virtual Panel Templates 

To create a virtual panel template:  

1. Right click a virtual panel in the Device View area and select Create Panel Template (see Figure 160): 

 
Figure 160: Creating a Virtual Panel Template 

The virtual panel is saved to the Panel Templates directory on your PC for future use. 

To insert a panel template (into a different project in this example):  

1. Right-click the virtual panel. 

2. Select a virtual panel from the Insert Panel Template List. 
DVD Controller in this example. 

 
Figure 161: Selecting a Virtual Panel Template 

The virtual panel is added beneath: 

 
Figure 162: Virtual Panel Template in the Device View 
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Note that you cannot delete a virtual panel that has been added. You can only do this by deleting the 
virtual keypad device via the Project Navigator. 

6.4.3 Selecting the Main Panel 

When the Virtual Keypad device includes several virtual panels, by default, the first panel is set as the main panel 
which is initially presented upon program start. You can set a different panel to be the main (first) panel. 

To select a new main panel: 

1. Right-click a virtual panel that is not first in the device view. 
In the following example, there are two virtual panels included in the DVD Controller Virtual Keypad device. 

 
Figure 163: Setting a Virtual Panel to be the Main Panel 

The Main Panel will move to be the first panel in the sequence of panels: 

 
Figure 164: New Main Virtual Panel 
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6.4.4 Creating links 

When creating a virtual device with multiple panels you can add a link from one panel to another via the Link feature 
when editing the button. In the following example the Virtual Device (Room 5) has three panels; you can set a link from 
one panel to the other by editing a button and creating a link to one of the other panels. This feature is very useful 
when using touch panels such as tablets or smartphones, and will let you switch from one control UI page to the other 
with a press of a button. 

For example, you can set a button on the main panel to turn on the power on the projector and also link that button to a 
new panel which incorporates all the project features. One of the buttons in this new panel could be set for turning off 
the projector power and also link to the main panel. 

  
Figure 165: Virtual Device – Link to another Panel 

A button with a link will appear as follows: 

 

Figure 166: Virtual Device – a Button with a Link 

 

 
The Virtual Device View button sizes, as well as their name and location in K-CONFIG have no functional 
meaning in the Virtual Device application. 

Only the number of defined buttons, the knob and the text label (interactive field text) have functional 
meaning and are correlated to the Virtual Keypad device application. 

6.4.5 Virtual Device Shortcuts 

You can right-click the virtual device line in the Project Navigator area to perform various operations for different virtual 
keypad devices. This section shows different examples of operations that are available for auxiliary devices. 

Generally the shortcuts let you: 

• Delete the virtual keypad device. 

• Add a description of the virtual keypad device. 

• Edit the virtual keypad device view (see Section  6.4.1). 

• Export the device xml, letting you export a virtual keypad device for sharing its design with another project 
configured program (see Section  4.2.1.3). 

The following sections describe additional shortcuts. 
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6.4.5.1 Save a Virtual Keypad Device Template 

To add a virtual keypad device as a template, right-click the virtual device and click Save as Template: 

 
Figure 167: Virtual Keypad Device Shortcuts – Saving as a Template 

The following message appears: 

 
Figure 168: Virtual Device Shortcuts – Saved as a Template 

The template is added to the virtual devices templates list (for use when adding a virtual device template). 

 
Figure 169: Virtual Device Shortcuts – New Template Added 

6.4.5.2 Setting a Virtual Device to be the Same As Another Virtual Device 

When more than one virtual device is defined in a controlled room, you can set one or more of them to be the exact 
same as one of the other virtual keypad devices: 

 
Figure 170: Virtua Device Shortcuts – Setting the Same As 
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6.5 Adding the Virtual Device Templates 

The virtual device templates include a pre-designed virtual device with selectable pre-designed virtual panels, to help 
you quickly design virtual panels. Each template includes several selectable panels. You can choose a design and 
then choose the type of panels you need. You can set the Virtual device templates in the same way as a virtual device 
(see Section  6.4). 

 

 
The virtual device templates are compatible with Master room controllers with ETH port and which can 
accept auxiliary devices. 

To add the virtual device templates: 

1. In the project Navigator area, select the Master Controller and click the + icon. 
The ADD AUXILIARY DEVICE window appears. 

2. Open the Virtual Device Templates category and select a template from the list. 

 
Figure 171: Virtual Device Templates – Selecting the Template 
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Each template includes a group of eight selectable panels in the following categories (set for your convenience): Front 
Panel, Screens, Projector, Sound, Shades, Lights, Air conditioning and Front Panel 1.  

All of the eight panels are selected by default. You can deselect the panels you don’t need and leave the ones you 
want to use. In the following example Projector, Shades, Air Conditioning and Front Panel 1 were deselected: 

 
Figure 172: Virtual Device Templates – deselecting Panels 

6.5.1 Virtual Device Template Shortcuts  

You can right-click the virtual device Template line in the Project Navigator area to perform various operations for 
different devices. This section shows different examples of operations that are available for auxiliary devices. 

Generally the shortcuts let you: 

• Delete the virtual device. 

• Add a description of the virtual device. 

• Edit the virtual device view (see Section  6.4.1). 

• Export the device xml, letting you export a virtual device for sharing its design with another project configured 
program (see Section  4.2.1.3). 

• Save the device as a template, by adding it to the virtual device list for adding as an auxiliary virtual device. 

 
Figure 173: Virtual Template Device Shortcuts – Saving as a Template 
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6.6 The Room Controller Device View  

You can determine the appearance of the various room control device panels and determine their appearance as well 
as save templates for future use. The room control device can have multiple panels with graphic backgrounds, graphic 
buttons and icons, all fully customized according to user design demands, and can be saved as templates for future 
use. 

6.6.1 Setting the Appearance of the Panel  

You can set the way the background panel and buttons appear on the Web page. You can also set the function of the 
buttons and knobs on the panel. 

To change the panel background (color or image) right-click the panel background and select a color or image (see 
Figure 174): 

 
Figure 174: Device View – Editing the Panel Background 

The panel background changes as selected: 

    
Figure 175: Device View – Panel Background Examples 

To add an image to a button, right-click that button and select the desired image/icon (see Figure 176) 

 
Figure 176: The Device Front Panel – Adding an Image to a Button 

 

 
Note that buttons and knob functionalities are described in Section  8.2 and Section  8.2.1, respectively). 
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6.6.2 Setting the Button Label 

To set the button label right-click the button select Label and type the label name (DVD in this example). 

 
Figure 177: The Device Front Panel – Adding a Label to a Button 

Setting the Button Transparency on Virtual Panels 

The buttons on Virtual panels and virtual template panels can appear as buttons or set to be transparent for use as 
hidden buttons. 

To set the transparency: 

1. Right-click a button on the virtual panel. 

2. Set the transparency On.  
The Button is transparent and appears in dotted lines only (invisible on the Web page). 

   

 
Figure 178: Setting the Button Transparency on a Virtual Panel 
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7 Assigning the Controlled Devices to Master and Auxiliary Device Ports 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

The Port Manager window lists the ports on the selected room controller device (Master room controller or Auxiliary 
device) or standalone room controller for assigning controlled devices to its ports. It enables writing a description for 
the assigned device and assigning a default driver to each port.  

 

 
Note that ports on auxiliary devices can be used only for sending outgoing commands from the auxiliary 
device to an AV controlled device. If you need device responses to use Monitor Event triggers or Queries 
functions, which rely on bidirectional communication, connect the AV controlled device to the K-NET master 
room controller device. For similar reasons, GPI/O ports on the auxiliary devices will be disabled. 

In the following example, the project navigator includes the RC-74DL, the RC-63DL, the RC-53DLC and the SL-10, 
see Figure 179. 

 
Figure 179: The Control Room Example 

To set the ports of the Master device (for example, RC-74DL): 

1. Select 1-RC-74DL in the Project Navigator area. 

2. In the Windows menu, select Port Manager. 
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Figure 180: Select the Port Manager 

The following window appears: 

 
Figure 181: The RC-74DL Port Manager 

The list on the left shows the various RC-74DL ports: 

• RS-232 and RS-485 

• IR out 

• Relays 

• GPI/O 

• Ethernet ports 
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7.1 Assigning a Controlled Device Driver to an RS-232 / RS-485 / IR Port 

To assign a controlled device to an RS-232 / RS-485 / IR Port: 

1. Click the Select driver field next to [1-RC-74DL] RS-232.Terminal_Block_1. 
The following window opens. 
If the list does not include the drivers you need, you can import it by clicking the Import Drivers button. 

  
Figure 182: The Drivers Tree Window 

2. Select and double-click the vendor and then select the driver. 

  
Figure 183: Select the Driver 
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3. Click OK. 
The projector driver is assigned to the RS-232 port. 

  
Figure 184: Assigning a Driver to a Port  

4. If required, click the Description field to change the port description:  

  
Figure 185: Writing the Port Description 

5. In the same way add a driver to each of the other ports. 

6. Click the Properties field to define the Serial Settings for the serial ports: 

 
Figure 186: Serial Settings Window 
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When defining the ports of a master room controller which is Site-CTRL compatible, check the radio button 
“Main” to select the port which will appear in the main display of the Master room controller Web pages. The 
same display device will be monitored in the Site-CTRL overview page. 

You can click the clear button to reset the port to its default state (no driver attached). 

The driver that was assigned to the RS-232 port in the port manager will now appear automatically in the Action 
Editor area when that port is selected: 

 
Figure 187: Action Editor – Automatic Driver Selection 

 
Note that the driver should always be set via the Port Manager. Driver settings that are made via the Action 
Editor are not saved, and need to be set again every time an action is defined. 

The Project Navigator shows the assigned controlled devices in their appropriate place. For example, the VPL-PX41 
projector (described as Room 1 - Projector), appears under the Master room controller RC-74DL and the Kramer  
VP-771 scaler which was assigned to the RS-232 port of the RC-63DL auxiliary device (procedure not shown here) 
appears under RC-63DL: 

 
Figure 188: Project Navigator – Display of the Assigned Drivers  

In the same way any assigned device, will show in the Project navigator (for example, controlled devices connected via 
the  
RS-232 port, RS-485 port, IR OUT port, relays, and so on). 
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You can also choose to show the unused ports by checking the Show unused ports box: 

 
Figure 189: Project Navigator – Display of the Assigned and Unassigned (unused) Drivers  

7.2 Setting the Functionality of the GPI/O Port 

The GPI/O (General Purpose Input/Output) port functionality can be defined in the Port Manager as follows: 

• Analog Input, Digital Input and Digital Output modes 

• With or without the internal pull-up resistor 
In the K-CONFIG software this term is referred to as Pullup (as opposed to “pull-up”) 

• Threshold setup 
 

 
Note that only the GPI/O ports on the Master room controller can be activated. The GPI/O Ports on the 
auxiliary device do not appear in the port manager. 

Figure 190 shows the RC-74DL GPI/O ports in the Port Manager: 

  
Figure 190: Port Manager – Master RC GPI/O ports 

To set GPI/O, do the following: 

1. Select the Master RC that includes the GPI/O feature (for example, RC-74DL which has two GPI/O ports). 

2. Select the Port Manager window. 

3. In the GPI/O.1 port, set the functionality of the port and name the port in the description box (for example, 
Temperature High for Digital Input, see Figure 191).  
You have to set the port functionality before you add commands to action lists. 

  
Figure 191: Port Manager – Selecting Digital Input for a Temperature Sensor 

4. Select one of the options described in the following sections. 
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7.2.1 Digital Input 

Digital Input mode reads the digital input of an external sensor device that is connected to the GPI/O port, and can be 
defined: 

 With Pullup: by configuring in this way, the room controller can be used to detect an open circuit 
(which is detected as Hi); or a short to ground (which is detected as Lo). This is suitable for 
example, for a pushbutton switch (connecting one terminal of the switch to ground, and the other to 
the input) or for an alarm closing a circuit that activates a series of actions. 

 Without Pullup: the room controller detects the voltage levels and translates them to High or Low 
according to the user defined threshold levels. 
For example, a high temperature alarm that exceeds the maximum voltage threshold. 

Setting the Digital Input  

In this example, an alarm causes a short circuit, thus activating a trigger. 

To set the trigger: 

1. Define the GPI/O in the Port Manager. 
Check Pullup for short circuit detection; the threshold is set automatically (skip step 2): 

 

Do not check Pullup for voltage level detection; the threshold to be set by the user (proceed to step 2): 

 

2. Click the Threshold button to define the GPI/O Threshold (minimum from 0 and maximum up to 30V) 
according to the indication set by the controlled device (other voltages will not activate the trigger). 

 
Figure 192: GPI/O Threshold Window 

To learn more about GPI/O Events, go to Section  8.4. 

7.2.2 Digital Output 

The digital output mode function is defined by the pull-up resistor setup: 

• Without Pullup: The port is used for controlling external devices such as room or light switches. The external 
source device determines the voltage output; the maximum voltage is 30V DC and the maximum current is 
50mA. 
Note: take care that the current in this configuration does not exceed 50mA! 

• With Pullup: the port can be used for controlling devices that accept a TTL signal such as for powering LEDs. 
The voltage output is TTL positive logic: open: ~2.4V; closed: ~0.2V. 
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Setting the Digital Output  

Define the GPI/O in the Port Manager: 

 

Once defined as Digital Output, the GPI/O port will appear in the Action Editor > Port Switch: 

  

Figure 193: The GPI/O Defined as Digital Output Mode 

7.2.3 Analog Input 

The analog input mode accepts an analog external device, such as, a volume control device: 

 

The Pullup and Threshold features are disabled. 

The trigger is activated once when the voltage is within the specified voltage range. 

7.3 Assigning a Controlled Device Driver to an Ethernet Port 

The Ethernet ports let you send control commands via the Ethernet port to up to 15 IP addresses located on the same 
subnet and associated with IP controlled devices.  

To define an Ethernet port, do the following:  

1. Set the Ethernet port Driver and Description. 

 

2. Click the Properties field to define the Ethernet Settings: 

                                
Figure 194: Ethernet Settings Example 
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 The Ethernet port settings are complete: 

 
 

 
Note that clicking the Clear button will not reset the Ethernet properties. 

7.3.1 Setting the Volume Properties 

For Master controllers with an integrated power amplifier (for example, the SV-551 and SV-552) you can set the 
volume properties via the Port Manager (analog or digital), as illustrated in Figure 195. 

 

 

Figure 195: Set Volume Properties 

Set the volume control to:  

• Analog, if the volume of the integrated amplifier is controlled by an external analog audio knob (via the 
SV-551/SV-552 10k volume level input port, connected either to an analog audio knob of a K-NET auxiliary 
device such as the RC-63AL, or any other compatible volume level knob) 

• Digital, if the volume of the integrated audio power amplifier is controlled by an auxiliary device with a digital 
knob (for example, RC-63DL). In this example, the amplifier port should be “assigned” via the Port Manager to 
the relevant RC-63DL to achieve volume control.  
For digital audio level control, select the auxiliary device that will control the audio 
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8 Using the Triggers 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

A trigger initiates a series of actions that can be activated by an event, a press of a button or a preset schedule. The 
triggers are listed as events that trigger a series of user-configured actions: 

• Custom Events – include four built-in triggers. Other custom events can be added via K-CONFIG (see 
Section  8.1). 

• Keypad Events – add triggers to Keypad events by clicking a keypad panel button or knob on the master room 
controller and auxiliary devices (see Section  8.2). 

• Monitor Events – add triggers to the monitor event by setting an incoming command that will onset a series of 
user-configured actions (see Section  8.3). 

• GPI/O Events – add a GPI/O trigger to activate a series of user-configured actions following a controlled sensor 
indication such as an alarm set, for example (see Section  8.4). 

• Timer Events – add timer triggers that will start a timer following timer stop/start states (see Section  8.5). 

• Query Events – query a controlled device to start a series of user-configured actions according to monitored 
operation parameters such as projector lamp hours and the power status of the main display (for example, a 
projector), see Section  8.6.  
Note that query Events will not appear on the Triggers list for devices that do not have Ethernet. 

• Sub Routines – when the same series of user-configured actions repeats itself in several action lists, you can 
define a Sub Routine once and use it in all these action lists to save configuration time (see Section  8.7). 

Figure 196 shows the trigger list and its available operations: 
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Figure 196: The Standard Built-in Triggers List 

You can: Expand the trigger list 
 

 Collapse the trigger list 
 

 Add a new trigger 
 

 Delete a trigger 
 

 Clear the trigger actions 
 

 Move a trigger up in the trigger list 
 

 Move a trigger down in the trigger list 
 

 Paste actions to a selected trigger 
 

 Copy the actions from a selected 
trigger  

 Edit a trigger 
 

 

 
Note that not all the actions are available for all types of triggers. 

8.1 The Custom Events Trigger  

The built-in triggers within the Custom Events are important for proper operation of the system and cannot be deleted: 

• The Device Startup trigger – is executed on configured device power up and lets you assign a series of actions 
that will define the status of the room controlled system following power-up, and will constitute the basic system 
state.  
For example, define the light status of the OFF button of the keypad device upon power up; set the main display 
status to OFF and so on. 
We recommend that you use this trigger to wake up the room to a known and pre-configured state. 
For VP-81KSI only, startup is defined as detection of a PC-Graphics input signal. 

• The Device Inactivity trigger – lets you define the room status in case of monitored device inactivity for a 
preconfigured period (from 0 to 180 minutes) and is set by right-clicking the trigger and editing the inactivity time 
interval. For example, power down the main display and then roll up the projector screen after the inactivity 
preset time. 
Device inactivity means that no button was pressed on a room controller device. Note that, for VP-81KSI only, inactivity relates 
to the incoming syncs on the PC Graphics input channels. 

• The All Off and All On triggers – the actions assigned to the All Off and All On triggers apply to the On and Off 
actions in the Site-CTRL Management Tool software, as well as in the built-in Web pages Macro tab. 

• Custom – you can add new scheduling triggers to the custom events list. A button that is used to trigger the 
defined custom triggers will be available on the Web page of the main room controller. 
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To add actions to a custom trigger, for example, the Device Startup trigger: 

1. Select the Device Startup trigger: 

 
Figure 197: Custom Events – Selecting the Device Startup Trigger 

2. In the Action Editor, select a Port Command: 

 
Figure 198: Custom Events – Selecting the Power On Command 

The Action Editor shows the ports and commands relevant to both the RC-74DL and the RC-63DL (see Figure 199). 

  
Figure 199: The Action Editor for RC-74DL and RC-63DL 
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3. Click the Add to List button. 
The command is added to the Device Startup trigger 

 
Figure 200: Custom Events – Command added to the Action List 

4. In the same way, add all the relevant commands to the Device Startup trigger. 
The trigger appears bold in the list. 

 
Figure 201: Custom Events – Commands added to the Action List 

To add a new custom event: 

1. Select Custom Events. 

 
Figure 202: Custom Events – Add a New Trigger 

2. Click the + icon and type the new name. 

                         
Figure 203: Custom Events – Add a New Trigger Name 

3. Click OK. 
If the configuration is not finalized, finalize it now. 
The new trigger is added to the Custom Events trigger list and the Scheduling window automatically opens, 
see Figure 204 (you can open it always by clicking the  icon, or right-clicking the trigger). 

For room controller devices with internal clocks, the scheduling process lets you activate All Off, All On and Custom 
trigger actions according to a preset schedule. The room controller device's internal clock will synchronize with the host 
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PC clock when uploading the configuration file to the device, so if scheduling is used, you have to verify that the PC 
clock is set appropriately. 

 
Before setting the schedule, you need to set the room controller device’s date and time (see 
Section  10.6.1). 

 
Figure 204: Custom Events – The Scheduling Window 

The following examples show different schedules setup for deactivating a room controlled system. In each example, 
the Time, the Active Trigger, the Description of the selected schedule and the required days (Repeat Every) are 
set, and custom triggers are added as needed: 

 
Figure 205: Custom Events – The Scheduling Example 1 
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Figure 206: Custom Events – The Scheduling Example 2 

8.2 Keypad Events Trigger 

Trigger Event triggers include user-configured actions that are triggered by pressing a certain button on a room 
controller device in the controlled room. 

To set a Keypad trigger, for example, pressing the SOURCES button (3) on the RC-63DL auxiliary device: 

1. Click the SOURCES button.  
The selected button frame turns blue and the edit icon appears: 

                     
Figure 207: Keypad Events – Selecting a Button 

2. Check and set the appropriate button behavior: 
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 Activate on Release: activates the 
trigger upon button release. 

 

 Press-Release: activates a trigger 
(Press) all the while the button is 
pressed and another trigger (Release) 
when the button is released. 

 

 

 Activate while Pressed: the trigger is 
activated again and again as long as the 
button is pressed. You can set the 
trigger delay time (Start After…), as 
well as the repetition delay time (Repeat 
Every…). 
Note that time is set in 1/10th of a 
second intervals.  

 Toggle 1-2-3-4: select the number of toggle states (from 
2 to 10). With each press of the button, the next toggle 
state is activated (upon completion of that toggle). When 
in the last toggle state, the next press of the button will 
activate the first toggle state once again.  
We recommend that you assign a different button color 
command to each trigger state so that you can identify 
each toggle state by the associated color of the button. 
For example, the toggle button could be set to have two 
states and used as an on/off switch. The first press of the 
button will trigger an “On” action list. The next press on 
the same button will trigger the “Off” action list. 
Note that not all room controllers can have up to 10 
toggle states, some have less. 
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 States: select the number of states from 2 to 4. The state 
of the button can be changed through Panels Status in 
the Action Editor. 
Each button state is independent of the other. The state 
behavior lets you determine which sequence of actions 
(as defined for each state) will be carried out the next 
time this button is pressed.  
For example, if you need to control two projectors, you 
can use one (selector) button to select between the two 
and a set of three other (control) buttons to control the 
selected projector. Each of the three control buttons is 
set to two states: state 1 relates to projector 1 actions 
and state 2 relates to projector 2 actions. The selection 
button is set to two toggle states: toggle 1 sets the state 
of the control buttons to 1 and the next toggle sets it to 
projector 2.  
Pressing the selector button will change the state of the 
other three buttons to control the selected projector. See 
Section  9.4.1 for details on how to use Panels Status. 

 

In addition, you can set the button label and background image (see Section  6.6) 

When selecting the button behavior, the Keypad Events list shows the behavior of the buttons. In the example in 
Figure 208 Button 3 is set to States, Button 4 is set to Toggle, Button 1 is set to Activate while Pressed (Click) and 
button 2 is set to Activate on release (Hold). 

 
Figure 208: Button Behavior in the Triggers List 

3. Add actions to the trigger list (see Section  9). 

8.2.1 Knob Keypad Events 

The knob Keypad Event is especially useful when trying to control audio amplifiers or similar devices using serial 
command tables (see Section  9.2.1). Simply add the command table to the action list that is assigned to the knob. 

 

 
When controlling the built-in amplifier of the SV-551/SV-552 via the digital knob of the RC-63D series or 
RC-53D series units, you do not need to configure the digital knob behavior via the knob turning trigger. 
All you have to do is to associate the digital audio knob of the user interface unit with the SV-551/SV-552 
audio amplifier on their port manager tab. 

The knob triggers are activated by clicking the knob on the keypad device panel. The knob frame turns blue: 
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Figure 209: The Knob Triggers 

Two general types of triggers are available, depending on the area in which you click on the knob. The upper area will 
add the Knob turn up trigger to the Keypad Events list and the lower part will add the Knob turn down trigger to the 
Keypad Events list: 

 
Figure 210: Keypad Events List 

You can also set the Knob turn up or turn down with states: 

 
Figure 211: The Knob Triggers with States 

Up to 4 states can be defined, as appears in the Triggers list (showing 2 states): 



 

K-CONFIG – Using the Triggers 115 

 

 
Figure 212: The Keypads Event List with States 

Add actions to the list (see Section  9.1).  

8.3 Monitor Events Triggers 

The monitor event is a trigger that activates a sequence of actions when a certain selected driver message, usually a 
reply of some sort, is detected coming from the connected controlled device on the relevant serial or Ethernet port (for 
example, the projector Power: Off command).  

 
Note that you need to set the serial reply commands on serial ports before creating a monitor event, 
otherwise the command drop down box in the Monitor Events Trigger window will be empty. Serial 
reply commands are set via the Driver Manager, see Section  5.3). 

Note that serial ports on auxiliary K-NET devices can be used only for outgoing serial commands, in contrast to the 
master room controller which supports bidirectional serial communication. Therefore, monitor event triggers can only 
be defined for the serial ports of the master room controller in a certain Room Control setup and not for the serial ports 
of the auxiliary K-NET devices. 

To add a monitor event trigger: 

1. Click the Add Monitor Event button. The Monitor Events Trigger window appears. Select the Port, Driver 
and Command that will trigger the monitor event actions: 

                                           

Figure 213: The Monitor Events Trigger Window 

2. Click OK.  
The Monitor Event is added to the available Triggers list:  
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Figure 214: Adding a Monitor Event to the Available Triggers List 

 
You can edit the trigger to respond to a different command by selecting that command and then clicking the 

 button. 

3. Add actions to the trigger (see Section  9). 

8.4 GPI/O Events Triggers 

The GPI/O (General Purpose Input/Output) port can be configured via the K-CONFIG software. Using GPI/O, you can 
select a wide range of events that can trigger a series of actions, for example, when an alarm is set or if the room 
temperature exceeds a certain value. 

Only GPI/O ports on the master room controller can be used in the Room Control setup (SL-12 is the master room 
controller in this example). The GPI/O ports are set in the port manager as follows: 

 
Figure 215: GPI/O Events – Port Manager Setup 

Digital output acts in the same way as do relays so it cannot be used as a trigger (see Section  9.3). 

Once the master room controller is set, the GPI/O Events appears in the Project Navigator: 

  
Figure 216: GPI/O Events – GPI/O in Project Navigator 

To create a GPI/O event: 

1. Select GPI/O Events and click + to create a new GPI/O trigger. The following window appears: 
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Figure 217: GPI/O Events – GPI/O Trigger Properties 

2. Select the GPI/O port from the list and its function behavior: 

                               
Figure 218: GPI/O Events – Digital Input: Selecting the GPI/O Port and Behavior 

3. Select the condition for activating the trigger. 

For Digital Input mode: 
Behavior Action Pullup Trigger Condition Description 
Level moved from High to 
Low 

Activates the trigger 
immediately 

checked Closing the circuit 
not checked voltage exceeding its maximum defined 

value 
Level Moved from Low to 
High 

Activates the trigger 
immediately 

checked Opening the circuit 
not checked voltage decreasing below its minimum 

defined value 
Level is High for: The trigger is activated on the 

first occurrence 
checked Circuit remains open 
not checked The voltage exceeding its maximum defined 

value and staying there for a set period of 
time (see Figure 219) 

Level is Low for: The trigger is activated after the 
defined timeout expires 

checked Circuit remains closed 
not checked The voltage decreasing below its minimum 

defined value and staying there for a set 
period of time (see Figure 219) 

         
Figure 219: GPI/O Events – Setting the Digital Input Condition Timeout 

For Analog Inputs 
Behavior Action 
Value is lower than Activates the trigger once the voltage is below the set voltage 
Value is Higher Activates the trigger once the voltage is above the set voltage 
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Value is between Activates the trigger once the voltage is within the set range of voltages 

    
Figure 220: GPI/O Events – Analog Input: Selecting the GPI/O Port and Behavior 

You can now add commands to the event (see Section  9.1). 

8.5 Timer Events Triggers 

Timer Events include Timer triggers that let the control system wait for a configured timeout or event to occur and then 
act accordingly. To add a new trigger, select Timer Events and right click it or click the + icon. 

8.5.1 Power ON Example 

In the following example, button 3 on the RC-63DL is used to turn the projector ON. If, after sending the power ON 
command, no suitable reply is received from the projector during the selected 5-second time period, the Timer trigger 
is executed (displaying some type of visible alert to the user or resending the ON commands, as defined by the user). 

If a suitable reply is received within the 5-second time period, it will trigger a predefined Monitor Event action list which 
stops the Timer trigger (see Figure 221) and prevents the alert or error from being sent. 

 
Figure 221: Timer Events – Timer Trigger Flowchart: Power ON Example  

This setup includes three simple steps: 

Step I: Define the Timer Trigger. 

Step II: Define the Button trigger (which includes the Timer Trigger Start state). 

Step III: Define the Monitor Event Trigger (which includes the Timer Trigger Stop state). 

Step I: Define the Timer Trigger 
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1. Select Timer Events and click the + icon to add a new timer trigger. 
The Timer Trigger name window appears. Type the Trigger Name (for example, PRJON) and set the 
timeout: 

  
Figure 222: Timer Events – Adding the Trigger Name and Timeout   

2. Click OK. 
The Timer trigger appears in the available Timer Events list: 

 
Figure 223: Timer Events – the Timer Trigger in the Triggers List 

3. Add the following actions (Button 3 blinks in red for 5 seconds (to indicate a problem) and then illuminates in 
green: 

4. Click OK. 

 

Figure 224: Timer Events – adding Button Status 

5. Click the Add to List button. 
The command is added to the Action List. 

6. Add a 5-second delay and then button illuminates green.  
The PRJON Timer trigger action list appears as follows: 
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Figure 225: Timer Events – the Timer Trigger Action List 

Step II: Define the Button Trigger 

7. Define a button trigger: Button 3 - Click (see Section  8.2). 

8. From the Action Type list select Port Command and add the projector power on (PWR_ON) command:  

   
Figure 226: Timer Events – Projector Power On Command in the Button Trigger Action List 

9. From the Action Editor list select Timer Start/Stop and select the relevant Timer Trigger (in this example, 
Timer – PRJON):  

   
Figure 227: Timer Events – Selecting the Timer Start/Stop Action 

10. Select Timer Trigger State Start and click Add to List: 
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Figure 228: Timer Events – Selecting the Timer Start/Stop Action (Start State Selected) 

The button trigger includes powering on the projector and starting the Timer Trigger. The Timer trigger actions will be 
executed within 5 seconds unless they are interrupted by the monitor event. 

   
Figure 229: Timer Events – Active Button Trigger Action List 

Step III: Define the Monitor Event 

11. Add a monitor event trigger and select the On reply from On command: 

 
Figure 230: Timer Trigger – Add the Monitor Event 

 Once the projector power is ON, the On reply from On activates the monitor event action(s). 

12. Add the required action to the trigger (Stop): 

 
Figure 231: Timer Trigger – Monitor Event Action List  
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Once the projector replies, the monitor event command is executed, the timer trigger is stopped and normal operation 
is carried on.  

The command list, shown in Figure 230, includes "ON reply from OFF". In some cases, the AV device will reply 
differently to the same command, depending on its state. When building timers combined with monitor event 
structures, be certain to take into account the various replies that may return from the AV controlled device and handle 
each one of them with an appropriate Monitor Event trigger. 

 

 
Note that a command name cannot include spaces. Some command names, in former versions had spaces. 
For your convenience these command names will still appear with spaces. If you want to change these 
names via the Common Commands Tree Editor, you will not be able to rewrite them back to their original 
names (with spaces).  

8.5.2 System Inactivity Example 

In this example, the Timer trigger is used to perform a sequence of actions if no signals are fed into the controlled AV 
room system for a predefined time period (for example, 20 minutes, see Figure 232). A switcher (for example – the 
Kramer VP-411DS) will send out a dedicated serial command once all PC sources are disconnected. We will use this 
command to trigger a 20 minute timer. Each action list executed during timer activity interval will start with a command 
to stop this timer. Upon System Inactivity timer timeout, we will shut down the display device and perform other shut off 
tasks. 

 
Figure 232: Timer Events – Timer Trigger Flowchart: Inactivity Example  

To indicate inactivity, you have to add a “Stop” trigger prior to the sequence of actions and a “Start” trigger upon 
completion of the actions sequence.  

This setup includes two steps: 

Step I: Define the Timer Trigger (which will be used for all the triggers) 

Step II: Define the Button (and other) triggers 

Step I: Define the Timer Trigger 

1. Select Timer Events and click the + icon to open the Timer Trigger window. 
The Timer Trigger window appears. Type the Trigger Name and set the timeout to 20 minutes (for example, 
System Inactivity): 
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Figure 233: Timer Events – the Timer Trigger Name Window (Inactivity) 

2. Click OK. 
The Timer trigger appears in the available triggers list: 

 
Figure 234: Timer Events – the Timer Trigger in the Triggers List (System Inactivity) 

3. Add the following actions (having each button on the RC-63DL blink and then remain on, or any other 
commands added): 

 
Figure 235: Timer Events – Timer Trigger Action List 

Step II: Define the button (or other) Trigger 

4. Select a trigger from the Triggers list (for example, Button 1): 

 
Figure 236: Timer Events – Button 1 Action List 
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5. Add the Timer Stop trigger: 

  

Figure 237: Timer Events – Add the Stop Timer Action 

6. Move the added Stop Timer trigger to the top of the list using the arrow icons: 

 
Figure 238: Timer Events – Move the Stop Timer Action 

7. Add the Start Timer trigger: 

  
Figure 239: Timer Events – Add the Start Timer Action 
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8. Figure 240 shows the Button 1 trigger action list: 

  
Figure 240: Timer Events – Button 1 Action List with Timer Triggers 

9. In the same way, you can add the Stop and Start actions to each trigger. 

Adding the Stop action prior to the actual executed action list, stops the System Inactivity trigger. 
The Start action that follows the action sequence starts the 20 minute timer and will be active until a button will be 
pressed or a trigger activated within the 20 minute period. 

8.6 Query Events 

Before creating a Query Event you need to define a Query via the Driver Manager (see Section  5.3.3), as follows: 
Driver Manager > Define Query Table> accept table and exit Driver Manager> Create a query event. 

To create a query event: 

1. Select Query Events and click the + icon. 
The following window appears: 

 
Figure 241: Query Events – The Query Events Window 

2. Select the Port and Driver (the driver appears automatically if defined in the port manager). 
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3. Select the Query. 
In this example, Power. 

 
Figure 242: Query Events – Select the Query 

Query results shows the query table as defined in the Driver Manager. In this example Off, On and Standby were 
defined.  

 
Figure 243: Query Events – The Query Results 



 

K-CONFIG – Using the Triggers 127 

 

4. Select the query results which will trigger an action list: 

 
Figure 244: Query Events – Select the Query Results 

5. Click OK to create the Query trigger.  
Selecting On means that after the power is on the query event will be triggered. 
By default queries are disabled (upon device startup). A query will be triggered only if the matching "Query start" action was 
executed from the Query Start/Stop action (see Section 9.9) or another trigger. (For example, a "Device startup" trigger or a 
button trigger). You can also stop a query from triggering by executing the "Query stop" action. 

 
Figure 245: Query Events – The Power-On Trigger 

6. Create the action list for this trigger. 
After adding commands to the list, the query trigger appears bold. 
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You can add more Power query events in accordance with the Query table defined in the Driver Manager. If checked, 
the Off and Standby Query results will also appear as separate Query Events: 

                  
Figure 246: Query Events – Creating Several Query Triggers 

Open the drop down box list to select the rate at which the query is sent (30 seconds, 1 minute, and so on).  

You can also add the following related triggers (which are relevant only for parsed replies, when the Parse Reply 
option in the Driver Manager is checked): 

• Set trigger when response doesn’t match any analyzing rule – If the controller recognizes in an incoming 
command the structure defined as ”reply must contain the following syntax” but the parsed relevant information 
does not match any of the used results for this query, a no match event will be triggered (NoMatch).  

• Set trigger when no response from device (according to the time or containing limits) – If the controlled 
device reply to the query command cannot be parsed, a communication Error query event is triggered 
(CommErr). Define the number of retries in case of a communication error (from 1 to 3), as well as the waiting 
time between each try (1 second, 3 seconds, and so on). 

Use queries to define the Site-CTRL monitored operation parameters (such as the projector lamp hours and the power 
status of the main display device). The list of available queries appears in the Queries area in the Driver Manager (see 
Section  5.3.3). 

8.7 Sub Routines 

Sub routines include triggers that have action lists of common procedures. These common procedures can be 
incorporated into other event triggers as many times as required. 

To use a sub routine: 

1. Select Action Groups from the Triggers list and click the + icon. The following window appears: 

 
Figure 247: Sub Routines – Create a new Action Group Trigger 

2. Type the name: 

 
Figure 248: Sub Routines – Set the Sub Routine Trigger Name  
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3. Click OK and add actions to the trigger (see Section  9): 

 
Figure 249: Sub Routines – Set the Action Group Trigger Name 

 In this example, the subroutine includes power down of the input sources and it can be incorporated into daily 
and/or weekly shutdown triggers, GPI/O events (temperature alarm, for example), and so on. This sequence of 
commands will not have to be written again and again for specific triggers and can be used as a sub routine 
within a trigger as required. 

4. Open or create an Event Trigger (for example, one of the built-in Custom Events, All Off).  

5. In the Action Editor select Sub Routines and add the Sub Routine see Figure 250. 

 
Figure 250: Sub Routines – Selecting the Sub Routine Action Group Trigger in the Action Editor 
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6. Click the Add to List button. 
The sub routine was added to the All Off Custom Event: 

 
Figure 251: Sub Routines – Sub Routine Trigger is added to an Event Trigger 

In the same way you can add Sub Routines to other events as well as to other sub routines. 
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9 Adding Actions to a Trigger 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

K-CONFIG lets you add actions to the different types of triggers that are built-in or created via the Triggers list. This 
section describes the different types of actions within the following categories that can be added to the action list: 

• Port Command (Section  9.2) 

• Port Switch (Section  9.3) 

• Panels Status (Section  9.4) 

• Switcher Command (Section  9.5) 

• Power Amplifier (Section  9.6) 

• Timer Start/Stop (Section  9.7) 

• Delay (Section  9.8) 

• Query Start/Stop (Section  9.9) 

• Sub Routines (Section  9.10) 

• Site Control Message (Section  9.11) 
 

 
Note that only the relevant action types appear for each room configuration, therefore this section’s 
examples will show different types of room configurations.  

The Action Editor will show a list of the maximum available command categories. For example, if RC-13TC is the only 
controller controlled via K-CONFIG, the Action Editor will include Port Command, Panels Status, Delay and Site 
Control Messages. If RC-63DL is added as an auxiliary device, the Port Switch category is added to the Action Editor 
(for controlling the RC-63DL relays). This lets you control, for example, the relays on the RC-63DL via the RC-13TC. 
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9.1 General Instructions 

The Action Editor area is divided in two. The list of available action types is listed on the left and once an action type 
is selected, the available actions appear on the right. 

For example, the Switcher Command Action Editor displays the following available action types: 

 
Figure 252: The Action Editor – Available Action Types 

Generally, actions are added to triggers via the Action Editor in a similar way: 

1. Select the Trigger. 

2. Select an action type and relevant action.  

3. Click the Add to List button. 
The action is added to the trigger. 

At any time you can move the action up or down the list, delete it or duplicate it using the icons above the action list. 
 

 
At any time you can add delete or change a trigger. Note that in some cases it will affect other triggers. 
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9.2 Adding a Port Command  

To add actions to a trigger (for example, to the built-in All On trigger): 

1. In the Triggers area, select the All On trigger. 

2. In the Action Editor, select the Port Command and select the desired port. 
A specific driver was assigned to the selected port, therefore it is selected automatically 

 
Figure 253: Selecting the Port Command Action Type 

3. Select the Command (for example, PWR_ON): 
Note that PWR_ON is a shared command, previously defined in the Driver Manager (see Section 5). 

  
Figure 254: Selecting the Command 



 

134 K-CONFIG - Adding Actions to a Trigger 

 

4. Click the Add to List button. 
The command is added to the Action List area (the trigger name appears at the top of the list): 

 
Figure 255: The New Command in the Action List 

5. In the same way you can use the Action Editor to add further commands to the action list: 

 
Figure 256: The Action List for the All On Trigger 

You can: Delete an action 
 

 Duplicate an action 
 

 Copy and Paste an action 
  

 Move actions up or down 
  

Once a Trigger’s action list is assigned with commands, it turns bold: 

  
Figure 257: The All On Trigger (after adding commands to the action list) 
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9.2.1 Adding a Table Action 

After creating tables via the Driver Manager (see Section  5.5.4) you can use it in the action editor Port Command list: 

 
Figure 258: The Table Port Command 

Select the: 

• Table (Output_Volume). 

• Select the room controller device whose LEDs should behave as defined in the table (RC-63DL). Select None if 
you do not want the LEDs to behave as defined in the commands table. 

• Set the behavior of the table commands to go gradually up, down, or set to a specific value. If you click Set, you 
can choose a specific volume level (see Figure 259): 

  
Figure 259: The Table Port Command – Setting a specific Volume Level 
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Add the command to the Action list: 

  
Figure 260: The Table Port Command – Added to the Action List 

You can create several other tables for different commands, or combine different command levels in the same table.  

9.3 Adding a Port Switch Action  

The port switch action lets you open/close relay ports or GPI/O configured as digital outputs on the master room 
controller and auxiliary devices or control gateways. 

  
Figure 261: Selecting the Port Switch Action Type 

Select the port and check the desired action (Open or Close) and add to the action list: 

 
Figure 262: Port Switch Action Type added to the Action List 
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9.4 Adding a Panels Status Action 

The Panels Status Action type lets you set various parameters on each of the master and auxiliary device buttons. 
Note that you can define only one panel status per command.  

Figure 263 shows the Panel Status Action Editor. The control keypad device (RC-74DL) and the auxiliary keypad 
devices panels appear on the right side. The left side shows the various actions: 

• Button Status, see Section  9.4.1 

• LCD Label, see Section  9.4.2 

• LEDs Light, see Section  9.4.3 

• Panel Lock, see Section  9.4.4 

 

 
Figure 263: Panels Status Action Editor 

 

 
Note that the availability of the Panels Status actions changes in accordance with the room controller device 
specifications. For example, the SV-552 does not have multicolored illuminated buttons, therefore the button 
status action is disabled for this device. 

Figure 264 shows Panels Status commands that were added to the action list. The list shows a general name for each 
action. For example, even though “Buttons Action” appears twice, it includes different actions related to the panel 
buttons. 

 
Figure 264: Panels Status Action List 
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When an action is selected, the details of that action will appear in the Action Editor. For example, selecting the Panels 
Action shows that RC-74DL is locked and the LCD Action shows the RC-74DL LCD displaying the date: 

              
Figure 265: Panels Status Action – as Appears in the Action Editor 

9.4.1 The Button Status 

The Button Status lets you define a button’s behavior and set its light color, as well as enable/disable it or set its 
state. 

To define the button status:  

1. Choose the Panels Status tab. 

2. Click a front panel button in the Action Editor (for example button 1 on the RC-74DL). 
The button frame turns blue: 

  
Figure 266: Panels Status – Selecting a Button 

Note that only the relevant actions are available for each button type. 
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Select Button Light Color and choose the 
button behavior to No Change (there is no other 
change in the current button behavior except for 
the color change), Off, On, Slow Blink or Fast 
Blink. 

For No change and Off there is no color to 
select; for On, Slow Blink and Fast Blink select 
a color + intensity (one of three levels). 

 
 

 

Select Button Enable to disable or enable the 
button. 

 

Select Button State to define the state of the 
button (first you need to set the button behavior, 
see Section  8.2. In this example the button 
behavior was set to four states). For each state 
you can set the button appearance. 

 

Select Groups to group several buttons and give 
them a name so that you can set the behavior of 
a group of buttons instead of changing each 
button separately (see Section  8.2). 
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9.4.1.1 Using the Groups Feature 

In this example Button 1 on the RC-63DL is set to 10 toggles. In each toggle buttons 1 and 2 need to change colors. 

To use the Group feature in this case, select the Panels Status Action Editor and do the following: 

Hold the CTRL button on your 
keyboard and select buttons 1 
and 2. 

 

 

Select Groups and click + to 
open a name text box. 

 

Type the name of the group. 

  

Select Groups to group 
several buttons and give them 
a name so that you can set 
the behavior of a group of 
buttons instead of changing 
each button separately (see 
Section  8.2). 
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The selected button 
color is applied to 
the buttons in the 
defined group 
selecting. 

 

 

9.4.2 The LCD Label 

LCD Label lets you alter an LCD label on the front panel of the device.  

To alter an LCD label on the room controller keypad of the device: 

1. Choose the Panels Status tab. 

2. Select the LCD Label (its frame turns blue). 

Check No Change and the current status will not 
change. 

 

Check Text and type a label text. 

 

Check Date/Time and select the date format, 
None, DD/MM/YY or MM/DD/YY and the time 
format, None, 12H or 24H. 

 

Check Blank to turn the label blank. 

 

 
Note that the front panel shows the button status previously set. 
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9.4.3 The Knob LEDs Light 

The knob LEDs light (located next to a digital audio knob) lets you select a room controller device and set the behavior 
of its LEDs. 

To define the knob LED lights behavior, click the “LEDs” on the left side of the knob: 

Check No Change and the current status will  
not change. 

 

Check Animation Up or Animation Down to set 
the turning-on direction of the knob LEDs. 

 

 

Check Custom and select the knob LEDs that 
should be turned on. 

 

Check All Off to turn off the knob LEDs. 
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9.4.4 The Panel Lock 

The Panel Lock lets you select a room controller device and lock its front panel buttons. To lock the front panel, click 
the room controller device panel area. The button frame turns blue, see Figure 267.  

   
Figure 267: Panel Status – Panel Lock 

Note that an unlock/lock icon appears on the top left side of the panel. 

   
Figure 268: Panel Status – Panel Lock or Unlock State 

9.5 Adding a Switcher Command 

The Switcher Command lets you select an input to switch to the outputs  

  
Figure 269: Switcher Command – Select an Input 

After selecting the input click the Add to List button. The new command is added to the selected trigger action list. 
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9.6 Adding an Audio Power Amplifier 

The Power Amplifier action lets you set the output volume for devices with built-in power amplifiers (SV-552 in this 
example). 

You can set the volume to a certain level, increase or decrease it or mute the volume (On or Off). 

 
Figure 270: Power Amplifier – Select an input 

After setting the desired volume behavior, click the Add to List button. 

9.7 Timer Start/Stop  

The Timer Start/Stop action lets you select a trigger and set its state to Start or Stop. Once the Timer triggers are 
defined, the Timer Start/Stop states will appear and will let you start the timer that activates/deactivates the Timer 
trigger action and stop it (see examples, in Section  8.5). 

 
Figure 271: Timer Start/Stop – Select a Timer Trigger 
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9.8 Delay 

The Delay action lets you set a delay time of up to 60 seconds between actions. Set the delay time and click the Add 
to List button. 

 
Figure 272: Delay – Set the Delay Time 

9.9 Query Start/Stop 

Query Start/Stop is used to trigger a query within the action list. To do so select the query and then select start or stop. 

 
Figure 273: Query Start/Stop – Selecting the Query Trigger 
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9.10 Adding Sub Routines 

Sub routines are enabled once a sub routine 
trigger is defined (see Section  8.7). After 
setting the sub routine trigger, you can add the 
sub routine trigger to any other trigger. This is 
helpful for using if you need to repeat a 
sequence of actions several times within a 
trigger or repeat the same sequence of action 
in several triggers. 

 

 
Figure 274: Sub Routines – Select a Sub Routine 

9.11 Site Control Message 

The Site Control Message action is used to send messages to Site-CTRL SW application and display them. 

Select the Port, the Query and the Status. If relevant, the status is set so that it fits the Site Control filtering 
categories. The message is typed as required. 

 
Figure 275: Site Control Message – Select the Query Event 

Note that the Status sets the level of the displayed message so that when in Site-CTRL messages can be filtered 
according to their levels of risk or importance this message will also be filtered in accordance with the Site-CTRL 
filtering levels. 

Note that if you select the LampHour query you need be sure that "Send parsed value" is checked, to allow the 
SiteCTRL main screen to show the Lamp Hour life in percentage. 
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10 Connecting to the Device 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

While many actions are available to K-CONFIG users without needing to connect to the device itself, the following 
actions require that the device is connected to your PC. These actions include: 

• Set the K-NET IDs, see Section  10.2 

• Firmware upgrade, see Section  10.3 

• General settings, see Section  10.4 

• Ethernet settings, see Section  10.5 

• Security settings, see Section  10.6 

• Date and time settings, see Section  10.6.1 

• Syncing the configuration to the device, see Section  10.7 

• Reading the configuration from the device, see Section  10.7.1 

• Clearing the configuration from the device, see Section  10.9 

You can connect your PC to: 

• A Master room controller device 

• An auxiliary device that is connected with a K-NET cable to its Master room controller. 

• An auxiliary device that is connected directly to the PC. 

10.1 Connecting Methods 

Before you perform any of the actions described above, you need to physically connect to the room controller device.  

This can be done in any of the following ways: 

• Connecting via the Ethernet 

• Connecting to the device via the RS-232 port (no null-modem is required).  

• Connecting the room controller device directly to your PC via the USB connector whether it is defined as an 
auxiliary device or a standalone Master room controller. 

You can connect only via the available ports on the room controller device. 

 
Note that you can read from a room controller device only via the Ethernet.  
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To connect a room controller device: 

1. Click the Connect button in the quick access toolbar. 
You can also select Connect from the Device menu. 

 
Figure 276: Connection Method Window 

Alternatively you can click the DISCOVER button to get a list of discovered room controller devices and then 
choose the desired room controller device from that list and click Connect. 

 
Figure 277: Discover Devices 

2. Select the Connection Method (Ethernet, Serial or USB). 

3. Enter the data that is relevant to the selected connection method: 

 UDP – the room controller device IP address and the port number.  
Click Default to return to the default IP address (Section  10.1.1). 

 TCP – the room controller device IP address and the port number (note that you have to set the port 
number to 50000).  
Click Default to return to the default IP address (Section  10.1.1). 

 Serial – select the port number to which the room controller device is connected and set the baud rate 
(Section  10.1.2). 

 USB – select the USB port to which the room controller device is connected.  
Click Refresh if a new port was added (Section  10.1.3). 
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If the project navigator room configuration does not reflect the actual controlled room, the following warning appears: 

 
Figure 278: Configuration Mismatch Warning 

10.1.1 Connecting via the Ethernet 

To connect via the Ethernet (UDP + TCP): 

1. Set your PC to enable Ethernet connection (see Section  10.1.1.1). 

2. Type the room controller device IP address. 

3. For TCP only, set the port number to 50000. 

4. Click Connect. 

10.1.1.1 Setting the ETHERNET Connection 

You can connect the room controller device (for example, the SV-551) via Ethernet using either of the following 
methods: 

• Directly to the PC using a crossover cable. 

• Via a network hub, switch, or router, using a straight-through cable. 

Connecting the ETHERNET Port directly to a PC (Crossover Cable) 

You can connect the Ethernet port of the room controller device to the Ethernet port on your PC, via a crossover cable 
with RJ-45 connectors.  

 

 
This type of connection is recommended for identification of the factory default  
IP Address of the room controller device (192.168.1.39) during the initial configuration. 

After connecting the Ethernet port, configure your PC as follows: 

1. Click Start > Control Panel > Network and Sharing Center. 

2. Click Change Adapter Settings. 

3. Highlight the network adapter you want to use to connect to the device and click Change settings of this 
connection. 
The Local Area Connection Properties window for the selected network adapter appears as shown in Figure 
279. 
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Figure 279: Local Area Connection Properties Window 

4. Highlight either Internet Protocol Version 6 (TCP/IPv6) or Internet Protocol Version 4 (TCP/IPv4) 
depending on the requirements of your IT system. 

5. Click Properties. 
The Internet Protocol Properties window relevant to your IT system appears as shown in Figure 280 or Figure 
281. 

 
Figure 280: Internet Protocol Version 4 Properties Window 
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Figure 281: Internet Protocol Version 6 Properties Window 

6. Select Use the following IP Address for static IP addressing and fill in the details as shown in Figure 282.  
For TCP/IPv4 you can use any IP address in the range 192.168.1.1 to 192.168.1.255 (excluding 192.168.1.39) 
that is provided by your IT department. 

 
Figure 282: Internet Protocol Properties Window 

7. Click OK. 

8. Click Close. 

Connecting the ETHERNET Port via a Network Hub (Straight-Through Cable) 

You can connect the Ethernet port of the room controller device to the Ethernet port on a network hub or network 
router, via a straight-through cable with RJ-45 connectors. 

10.1.2 Connecting via the RS-232 Port 

To connect via an RS-232 port: 

1. Select the PC COM number port to which the room controller device is connected. 

2. Select the baud rate. 

3. Click Connect. 
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10.1.3 Connecting via a USB Port 

To connect via a USB port: 

1. Select the PC COM port to which the room controller device is connected. 

2. Click Connect. 

10.2 Set the K-NET IDs 

Once the controlled room is ready, that is, the items are all actually installed you need to assign the KNET ID for the 
Master and auxiliary devices. The ID number of the master room controller is always 1, auxiliary devices will have a 
KNET ID from 2 and on, and the ID numbers allocated to the Virtual devices are 11 and 12. For example, in a 
controlled room, the Master controller is RC-74DL. One of the auxiliary devices connected is the SL-10. In order to 
communicate with the SL-10, you need to set the K-Net ID on the SL-10. 

 
Figure 283: KNET ID – A Controlled Room Setting Example 

By default, the following devices’ K-NET ID is set to 2 (auxiliary device) resulting in a communication error with  
K-CONFIG when trying to identify them as master room controllers (K-NET ID 1):  

• RC-62 

• RC-62X 

• RC-63A 

• RC-63D 

• RC-63DL 

• RC-63DLN 

In such cases, the devices’ K-NET ID must be set to 1 manually. For more information, see Section  10.2.1.  
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To set the K-NET ID to an auxiliary device: 

1. Right click the required auxiliary device in the Project Navigator area and select Set K-NET ID.  
The following window appears: 

  
Figure 284: KNET ID – Connect the Device Directly to PC 

2. Connect the auxiliary device (SL-10) directly to the PC (via USB) and then click OK. 

 
If you are connecting the device via USB for the first time, you might need to define the USB port. To 
do this, follow the instructions in Section  3.2. 

The Connection Method window appears: 

 
You might need to click Refresh Ports to have the USB port appear. 

 
Figure 285: KNET ID – The K-NET ID Connect Window 

3. Click Connect. 
The Setting K-NET™ ID window appears. 

 
Figure 286: KNET ID – Setting K-NET ID 

4. Click OK to set the ID number. 

 
Figure 287: KNET ID –K-NET ID assigned 
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10.2.1 Setting K-NET IDs Manually 

By default, the K-NET ID of the following devices is set to 2: 

• RC-62 

• RC-62X 

• RC-63A 

• RC-63D 

• RC-63DL 

• RC-63DLN 

In order for K-CONFIG to recognize the following devices as master room controllers, their K-NET ID must be set to 1 
using the MACH-NUM Protocol 3000 command. For more information about using Protocol 3000 commands, refer to the 
Protocol 3000 User Manual available at: www.kramerav.com. 

To manually set the K-NET ID to 1: 

1.  Connect the device to your PC via Ethernet, USB or RS-232.  

2.  Using standard telnet communication software, such as Hercules, send the following Protocol 3000 command: 

##MACH-NUM 01<CR> 

The K-NET ID is set to 1. Some devices may require a restart to complete this operation.  

10.3 Firmware Upgrade 
 

 
Before uploading a new firmware to a room controller device, make certain that the firmware you have 
selected matches the connected room controller device. In some cases, it will be possible to upload 
firmware that does not match a room controller device, resulting in inoperability of the room controller 
device. 

 

 
Before uploading a new firmware to a room controller device, disconnect it from Site-CTRL and Web 
Access. 

To load new firmware: 

1. Check for the latest firmware at: www.kramerav.com/manual/K-Config 3. 

2. Connect the room controller device. 

3. Select Firmware Update from the Device menu. 
The Firmware Update window appears: 

http://www.kramerav.com/
http://www.kramerav.com/manual/K-Config%203
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Figure 288: Firmware Update Window  

4. Select the room controller device to upgrade from the Select Device for FW Upgrade list box (SL-10 in this 
example). 
You can select the master room controller or any of the connected auxiliary devices. 

5. Click the Browse button to find the firmware file. 

 
Figure 289: Load Firmware Upgrade Window 

6. Click Upload. The following warning appears: 

 
Figure 290: Firmware Upgrade Warning 

7. Click OK. 
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Figure 291: Firmware Upgrade Process 

8. Upon Completion the following window appears: 

 
Figure 292: Firmware Upgrade Successful 

9. Click OK. 
Note that you might be asked to restart the unit. 

 
Figure 293: Firmware Upgrade Process Complete 

 10. Upon completion, open the Device Settings window to make sure the firmware was correctly upgraded. 
 

 

If the firmware version number remains the same, close the Device Properties windows, disconnect 
and then reconnect the device, and open the Device Properties window again to check the Firmware 
version number. 

Device setting readout is possible with standalone room controllers and K-NET master room controller or Aux K-NET 
devices connected with a K-NET cable to their master room controller, as defined in the Room Control tree. 
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10.4 Device Settings Window 

The Device Settings window reads the data from the connected room controller device. 

To connect the room controller device: 

1. Click the Connect button on the main window or select Connect from the Device menu. 
The Connect window appears (see Figure 38). 

2. Select the connection method to the standalone controller or master room controller and click the Connect 
button (in the Connection Method Window). 

 

 

Device setting readout is possible with standalone room controllers and K-NET master room controller 
or Aux K-NET devices connected with a K-NET cable to their master room controller, as defined in the 
Room Control tree. 

Figure 294 shows the general device settings tab, which includes the (master and auxiliary) room controller device 
information: Name, Model, Description, S.N (Serial Number), Firmware, K-Net-ID and the Unlock keypad PIN code text 
box where you can set the key pressing sequence to press to unlock the keypad in case it is locked by a trigger 
(activated by pressing a button, a schedule or via Web Access). 
Since the button key number does not appear on the actual keypad, the system integrator should inform the user regarding the key 
sequence. 

 
Figure 294: General Device Settings  

If you want to view the auxiliary device settings select that device in the Project Navigation area: 
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The Device Settings appears empty: 

 
Figure 295: Selecting an auxiliary device 

Click the Retrieve Device Details button. The following window appears: 

 

Click OK. The system retrieves the room controller device settings and the following window appears: 

 
Figure 296: Auxiliary Device Settings  
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Note that for some room controller devices (for example, the RC-52N) you can set the light intensity of the buttons 
(from 1 to 3); and for some room controller devices the light intensity is set to 3 and cannot be changed (for example. 
the RC-2): 

 
Figure 297: The Dim Light Power Feature  

 
Note that most room controller devices don’t have the Dim light power feature. 

10.5 The Ethernet Settings Tab 

Figure 298 shows the Ethernet information, which can be changed, if required: 

 
Figure 298: Ethernet Settings  

10.6 The Security Tab 

Figure 299 shows the Security Settings: 

 
Figure 299: Security Settings  

Function 
Secure Mode: OFF – the product definitions and configuration can be changed 

without requiring a password 
ON – a password is required to change the configuration and view 
or change the room controller device definitions 

User pass: This password lets you view the room controller device definitions 
in Web Access and Site-CTRL without changing the definitions 

Admin Pass Lets you change the room controller device definitions and 
configuration via Web Access and K-Config  
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Figure 300 shows the Date and Time settings (see Section  10.6.1): 

 

 

Figure 300: Date and Time Settings  

Function 
This area applies to room controller devices with an Ethernet connection 
and time server settings options and lets you set the room controller 
device’s internal clock to use with the scheduler (see Section  8.1). 
The date and time can be set either manually, via a local server or via the 
Ethernet 
Current Room 
Controller 
Device Time 
and Date 

Click the Read button to read the device’s current date 
and time 

Set Date and 
Time 

Click the Set Now button to set the date and time via one 
of the following options: 
From PC Clock (if No Sync is checked) 
You can check the box next to Set from PC on Write 
Configuration to have the date and time updated 
whenever writing a configuration 
Custom Date (if No Sync is checked) 

 Select a date and time from the drop down calendar 
Sync Date and 
Time 

Check radio button: 
No Sync – to read the date and time from the PC clock or 
by setting a custom date (see above) 
From Server Address – type an IP address to read from a 
server address 

DST Daylight Saving Time or Summer Time correction. Set to 
ON if necessary 

Timezone Set the time zone relevant to UTC (Coordinated Universal 
Time).  
The time zone can be set from -13 to +12 hours relative to 
UTC in 15 minute intervals (00, 15, 30 or 45 minute 
intervals).  
For example, the time zone in Adelaide, Australia is UTC 
+9:30, therefore 9:30 needs to be entered in Timezone for 
that particular location. 
If the value entered is out of range, the following message 
appears: 

 
Current server 
Sync Status 

Click the Read button to read the date and time on the 
server 
Note that the time displayed includes the DST and 
timezone modifications 

Current Server 
Time and Date 

Click the test button to check the status on the server 

 

 
Note that the Date and Time area appears only for room controller devices that include an Ethernet 
connector and support this function. 

10.6.1 Setting the Date and Time 

You can set the date and time on machines that have an Ethernet connector to use with the scheduler. You can set 
the time from several sources such as from a PC connected to the room controller device, an NTP (local) server, or the 
Ethernet. You can also set the time and date manually. 

To read the current date and time on the device, click the Read button: 

 

The device time and date appears: 
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The following table summarizes the date and time setting options: 

Set Date and Time Procedure  
From a connected PC Clock 1.  Click the “Set Now” 

button.  
 2.  Click Read (from device) 

to check the updated values.  
 If you want the time and date to be set whenever writing a configuration, check “Set from PC on 

Write Configuration”. 
   
Manually 1.  Click the dropdown box. 

 
 2.  Select the desired date 

and time from the dropdown 
box. 

 
 3.  Click the Set Now button.  

 
 4.  Click Read (from room 

controller device) to check 
the updated values.  

   
From a server address 
 

1.  In the Sync Date and 
Time area, check “From 
Server Address”. 

 
2.  Type the IP address. 
For example, 192.168.0.6 

 
 3.  Set the DST to ON (for 

adjusting the time to the 
“summer” clock) if required 
  

 4.  Set the time zone 
according to UTC. 
For example, the time in 
Jerusalem is  
UTC +2:00. 

 

 5.  Click the Read (from 
server) button (below the IP 
number).  

 6.  Click Read (from device) 
to check the updated values.  

 The room controller device 
updated date and time 
appear 

 

   
 In case there was a problem 

reading the date and time, 
the following message 
appears: 
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10.7 Syncing the Configuration to the Room Controller Device 

Once the configuration is ready, you can sync (write) the configuration to the room controller device, by selecting Sync 
Configuration to Device from the Device menu list. 

Note that: 

• In Master-Auxiliaries configurations, the configuration file is always written to the master room controller. 

• When using a standalone room controller, the configuration file is written to the room controller. 

In case you have written a configuration file to a room controller device and it is now connected as an auxiliary device 
to another master room controller, you have to define the device as an auxiliary device and upload an updated 
configuration file to the master room controller. 

Before writing the configuration to the device you have to save it as a project. 

To write a configuration to the room controller device, do the following: 

1. Connect the PC to the Master or the standalone room controller via the Ethernet/RS-232/USB.  

2. Click the Connect button (or select Connect from the Device menu list) or click Discover to discover the room 
controller device. 

 
Figure 301: Discovering a Room Controller Device 

The following message appears: 

 

3. In the Device menu, select Sync Configuration to Device (or click the Sync to Device button on the top 
right).  
You will be prompted to save the configuration as a project: 
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Figure 302: Loading a Configuration 

4. If required, change the file name and then click Save. 
The Write Configuration warning appears: 

 
Figure 303: Write Configuration warning  

If the KPR project file size exceeds its limit (see Section  10.7.1), the following warning appears: 

 
Figure 304: Write Configuration warning (without the KPR Project) 
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Note that during the Sync process, K-CONFIG writes the current configuration and saves (to its current 
project name) it as well. 

5. Click Yes. 
The Writing process appears on the top right part of the main window. After uploading the room controller 
device resets 

 
 

 
 

 
 

 
Figure 305: Writing Configuration and Device Resetting Process  

6. Upon completion, the following window appears: 

 
Figure 306: Writing Configuration Complete 

7. Click OK. 

10.7.1 Uploading the Project (*.kpr) File 

When syncing the configuration to the room controller device, you can define whether to upload or not upload the 
project file. This option is relevant only if the project file exceeds the size limit. 

Even if you set File > Upload Project > No, and the project file did not yet reach its size limit, it will still save the 
project file to the room controller device. 
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When almost reaching the limit, the project size box turns orange and once it exceeds the size limit it turns red. 

,  

Figure 307: Writing Project Complete 

Once exceeding the limit, and attempting to sync the configuration to the room controller device, the following 
message appears: 

 
Figure 308: Writing Complete 

10.8 Reading the Configuration from the Room Controller Device 

In order to read the Device configuration you have to add the system setup in the Project Navigator window. Note that 
you cannot read the room controller device configuration via the USB port. 

1. Connect the PC to the Master or the standalone room controller.  

2. Click the Connect button (or select Connect from the Device menu list). 

3. In the Device menu, select Read Configuration from Device.  
The following message appears: 

 
Figure 309: Read Configuration from Device – New Project Message 
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4. Click OK. 
Read is in Process: 

 
Figure 310: Read Configuration from Device – Reading Process 

 Upon completion, the following message appears: 

 
Figure 311: Read Configuration from Device – Reading Complete 

The Device configuration is now uploaded to the PC. 

10.9 Clear Configuration from Room Controller Device 

To clear the room controller device configuration: 

1. Connect the PC to the Master or the standalone room controller.  

2. Click the Connect button (or select Connect from the Device menu list). 

3. In the Device menu, select Clear Configuration from Device.  
The following message appears: 

 
Figure 312: Clearing Configuration from Device – Warning Message 
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4. Click OK. 
The device is being formatted and upon completion, the following message appears: 

 
Figure 313: Clearing Configuration from Device – Warning Message 

Any attempt to read the formatted room controller device now, results in the following message: 

 
Figure 314: Clearing Configuration from Room Controller Device – No File Loaded 
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11 Using the Embedded Web Pages 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

The Web pages let you control the controller and gateway device via the Ethernet and perform minor configuration 
operations. The Web pages include all the configured items and more, and are accessed using a Web browser and an 
Ethernet connection. 

 
Note that the Web page features are described in more detail throughout the guide.  

 To do so: 

• Connect the room controller device to the PC via the Ethernet (see instructions in the device’s user manual). 

• Make sure that your browser is supported 

The following operating systems and Web browsers are supported: 

 
Operating Systems Applicable Browser Versions and Higher 
Windows 7 and higher Chrome: 35 

Internet Explorer (32/64 bit) version 10 
Firefox 30 

Mac (PC) Chrome: 35 
Firefox: 30 
Safari: 7 

iOS Chrome: 35 
Safari (depends on the IOS version) 

Android OS Chrome: 25 

11.1 Browsing the K-CONFIG Web Pages 

Note that the Web pages reflect the configuration that was synced from K-CONFIG to the room controller device. Any 
change that is done in the Web pages (for example, scheduling) will remain only until the room controller device is 
once again synced (with same or new configuration). 

If the Ethernet/power cable was disconnected, the following message appears: 

 



 

K-CONFIG – Using the Embedded Web Pages 169 

 

Figure 315: The Embedded Web Pages – Communication Error Message 

Reconnect cables to restore Web page. 

To browse the K-CONFIG Web pages, make sure that the device is powered and connected to your PC via the 
Ethernet. 

Discover the room controller device: 

1. Open your Internet browser. 

2. Type the IP address of the room controller device in the Address bar of your browser. 
The Web page loads. 

 
Figure 316: The Embedded Web Pages – Loading the Web Pages 

11.2 The Room Controller Devices Web Page 

The room controller Devices Web page lists the master room controller device panel, slave keypad panel, and the 
Virtual device panels (with their K-Net IDs) as configured by K-CONFIG: 

 
Figure 317: The Embedded Web Pages – the Devices Web Page (and Pages List) 
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The Room Controller panel appears on the Web page exactly as it was configured in K-CONFIG: 

 

Figure 318: The Embedded Web Pages – Master Controller Panel 

Click the menu arrow to hide the Web page list: 

 
Figure 319: The Embedded Web Pages – The Devices Web Page 

The M icon next to RC-74DL designates a Master Device and the green mark indicates that the device is connected 
to the PC: 
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Click the + icon to see the controlled device drivers that were defined for the master room controller:  

 
Figure 320: The Embedded Web Pages – The Devices Web Page 

Click the blue arrow next to switch to single-panel mode in which each panel is displayed in a separate page: 

 
Figure 321: The Embedded Web Pages – The Virtual Device Panel 
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The virtual device configured in K-CONFIG appears in a new window and can be used to control the various devices. 
Click the home icon to return to the main page. The Other menu button was set up to link to yet another virtual panel. 
Click it to open the next virtual panel: 

 
Figure 322: The Embedded Web Pages – The Virtual Device Panel 

Click the X icon to display all the panels on one screen and scroll the page to view them. 

In K-CONFIG the Other menu button is configured to link to the next configured virtual panel: 

 
Figure 323: The Embedded Web Pages – Link to Front Panel 1 (in K-CONFIG) 
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The master controller lists the drivers. Click a driver on the list (for example VSM-4x4HFS) to view the groups of 
commands that have been defined in the K-CONFIG Driver Manager:  

 
Figure 324: The Embedded Web Pages – The Driver Command Groups 

Each category shows the active commands that are defined on the K-CONFIG Driver Manager. Click a group button to 
open and run any of the commands on the list: 

 
Figure 325: The Embedded Web Pages – VSM-4x4HFS Driver Command Buttons 
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For the TV, in this example, there will be a different set of commands configured (see Figure 327) that are related to 
the TV: 

 
Figure 326: The Embedded Web Pages – TV Driver Command Buttons 

In the K-CONFIG Action Editor you can find the commands defined in the configuration.  

 
Figure 327: The Embedded Web Pages – Action Editor 
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11.3 The Macros Web Page 

The Macros Web page lists all the macros that were configured in K-CONFIG and lets you run them by clicking the 
appropriate button: 

 
Figure 328: The Embedded Web Pages – The Macros Web Page 

11.4 The Scheduled Tasks Web Page 

The Scheduled tasks page displays the schedule setup that was configured in K-CONFIG together with the tasks that 
were added via the Web page (this example included no schedules in the configuration, therefore the Schedules tasks 
tables appears empty): 

 
Figure 329: The Embedded Web Pages – The Scheduled Tasks Web Page 

Hover over the table and click + to insert a macro: 

         
Figure 330: The Embedded Web Pages – Adding a Macro to the Schedule 
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After setting the schedule, click the Save button to save the setup: 

 
Figure 331: The Embedded Web Pages – Saving the Schedule 

The following warning appears: 

 
Figure 332: The Embedded Web Pages – Saving Warning 

Note that once a configuration is synced to the room controller device, this schedule will be deleted. 

You can also edit a schedule and then save it: 

     

Figure 333: The Embedded Web Pages – Editing a Macro 
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11.5 The Device Settings Web Page 

The Device settings Web page displays the device and security settings and lets you change some of the parameters:  

 
Figure 334: The Embedded Web Pages – The Device Settings Web Page 

11.6 The Date and Time Settings Web pages 

This page lets you set the time and date and is similar to the Date and Time tab in the K-CONFIG Device Settings:  

 
Figure 335: The Embedded Web Pages – Date and Time Settings 
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11.7 The About Web Page 

This page shows the Web page version and Kramer details: 

 
Figure 336: The Embedded Web Pages – The About Web Page 
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12 Creating a KRAMER NETWORK Virtual Master 

You are here: 

Configuration Steps Description Section 
Introduction General information and system requirements  1 
Planning Carefully plan your controlled room  2 
Installation Install the Software  3 
Introduction to K-Config  Get to know the K-Config main window, menus and quick access icons  4 
Driver Manager Define the Controlled Device Drivers  5 
Project Navigator Define the Controlled Room  6 
Port Manager Assign the controlled devices to the Master and Auxiliary device ports  7 
Triggers Activate the Triggers  8 
Adding Actions Describes how to add the various actions to a trigger  9 
Connecting to a Device Describes how to connect to a device, upgrade the firmware, read/write to the device 

and so on 
 10 

Using the Web pages Describes how to control the device via the Ethernet and perform minor configuration 
operations 

 11 

Creating a Virtual Master Describes how to create a Virtual Master to control a room via KRAMER NETWORK  12 

KRAMER NETWORK 1.0 is an IP-based enterprise management software platform for AV networks. Using any 
laptop, PC or tablet, KRAMER NETWORK lets IT managers to easily and remotely configure, route, control, and 
manage Kramer Pro-AV devices, room environments, and IP streaming devices from a single point in the network via 
a user-friendly Web-based interface. 

Using KRAMER NETWORK you can easily manage a room in a floor of a building which is part of a network site. One 
way of doing this is by using a KRAMER NETWORK Virtual Master room controller that is created in K-CONFIG. The 
KRAMER NETWORK Virtual Master control configuration is saved in K-CONFIG and is then uploaded to a room 
defined in KRAMER NETWORK. 

12.1 Opening a New Project 

The Virtual Master room controller device is designed to be displayed in the K-CONFIG Web pages and it includes 50 
Virtual Ethernet ports. You can connect the ports to various controlled devices via the Port Manager window and also 
add auxiliary devices. You can create the Virtual Master room controller by selecting either New Project or New K-
Network Project (a shortcut) from the File menu. 

To open a Kramer Network Virtual Master room controller: 

1. Select the Virtual-Master room controller from the ADD MASTER DEVICE window: 

 
Figure 337: Virtual Master Device – Selecting the Virtual-Master 
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2. Click OK. 
The virtual-master appears in the Project Navigator area: 

 
Figure 338: Virtual Master Device –the Virtual-Master in the Project navigator 

Click the + sign to add an auxiliary device to the Virtual-Master room controller: 

        

Figure 339: Virtual Master Device – Selecting an Auxiliary Device 

You can add three types of devices: 

• Control gateway devices (see Section  6.3) 

• Virtual keypad devices (see Section  6.4) 

• Virtual keypad device templates (see Section  6.5) 
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Set the master ports (via the Port Manager) and select the auxiliary devices (physical or virtual devices): 

 

Figure 340: Virtual Master Device – Room Configuration 

12.2 Syncing the Virtual Device Configuration to the Virtual Master Device 

To sync a configuration for use with KRAMER NETWORK: 

1. In the file menu, select Save Project As to save the Virtual Master configuration as a project. 

2. Click the Sync to Device button on the top right. 
The Export Configuration Krnt File window appears: 

 

Figure 341: Virtual Master Device – Syncing to Device 

3. Click the Save button. 

The Krnt file can be used for KRAMER NETWORK. 
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